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1. The INDOT CAD Workspace in ProjectWise 
INDOT delivers workspace resources to the majority of INDOT employees using a ProjectWise Managed 

workspace.  The following section covers a very high-level overview of what resources are directly 

available, and the usage experience that can be expected.  These resources drive the INDOT specific 

tools, workflows, and resources that will be covered throughout the remainder of the MicroStation 

Platform UI discussion later in this module. 

1.1 CAD Seed/Template Files 

There are several seed/template files that are used to provide the foundation for the many types of CAD 

files that INDOT uses.  These files can be found in the ORD-CONNECT Seed folder in ProjectWise under 

Template Documents. 

 

ORD-Connect Seed Folder Location in ProjectWise 

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/
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Contained within this folder are several seed files that are categorized by the different use cases for 

them. 

 

Contents of ORD-Connect Seed Folder 

The remainder of this section will give a brief description of these seed files. 

1.1-1  INDOT_US_SVFT Seed Files 
The INDOT_US_SVFT seed files are the most commonly used seed files in the plans production process.  

The 2D version is often used by the Design group to create the foundation for their design files, while 

the 3D version is often used by the Survey group as the foundation for displaying their survey data to 

designers in CAD form. 

1.1-2  DWG Creation Seed Files 
The seed files contained within the DWG Creation Seed Files folder assist the user when working with 

AutoCAD DWG files.  If a DWG file needs to be created directly, a seed.dwg file is provided.  If a DGN file 

needs to be created to bring in AutoCAD data into it, the various “transeed” seed files are provided. 

 

DWG Creation Seed Files 

1.1-3  Real Estate Seed Files (2D only) 
The Real Estate Seed Files folder contains the seed files most often used specifically by the Real Estate 

group. 

 

Real Estate Seed Files (2D only) 

  

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/DWG%20Creation%20Seed%20Files/seed.dwg
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1.1-4  Sheets 
The Sheets folder contains the seed files used to create plan sheets.  The 

INDOT_US_SVFT_2D_Drawing_Seed file is the base seed file for a drawing model, while the 

INDOT_US_SVFT_2D_Sheet_Seed file is the base seed file for a sheet model.  Note that you should 

rarely have to use these seed files in this form—as they are already built into the sheet seeds that are 

utilized in the plans production process. 

 

Sheets Seed Files 

1.1-5  Standards Seed Files 
The Standards Seed Files folder contains the seed files specifically used by the Standards group.  The  file 

is used for the creation of content for the Design Manual, and the Standards_Seed2D file is used for the 

creation of standard drawings. 

 

Standards Seed Files 

1.1-6  Survey Seed Files 
The Survey Seed Files folder contains the seed files most commonly used by the Survey group.  The  

esri_cad.wld and IN_GeoCS.dty files assist the Survey group in applying geocoordination to their survey 

data, while the  file assists the Survey in creating content for route plats. 

 

Survey Seed Files 

1.2 Revised Template Sheet Models 

All INDOT CAD sheet models have been split into 2 separate files: 

D size_sheets.dgn :  All 24 x 36 (D size) sheet models now reside in this design file. 

Ltr_sheets.dgn:  All 8.5 x 11 (letter size) sheet models now reside in this design file. 

In addition to separating the large format sheet models from the smaller ones, MicroStation’s ability to 

convert units on the fly has allowed for the metric versions of these sheet models to be removed. 

  

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/Sheets/INDOT_US_SVFT_2D_Drawing_Seed.dgn
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/Sheets/INDOT_US_SVFT_2D_Sheet_Seed.dgn
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/Standards%20Seed%20Files/Standards_Seed2D.dgn
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/Survey%20Seed%20Files/esri_cad.wld
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/Survey%20Seed%20Files/IN_GeoCS.dty
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/DGN/D%20size_sheets.dgn
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/DGN/Ltr_sheets.dgn


 
8 

1.3 The ProjectWise Managed Workspace 

The Managed Workspace is a feature of ProjectWise that allows MicroStation workspace files to be 

managed within the ProjectWise environment.  The benefits of doing this are that all workspace files are 

located and administered in a single location.  This allows for the rapid deployment of updates and 

changes, while allowing flexibility in what and how workspace resources are accessed. 

Note: Be aware that if you are working outside of ProjectWise or if you’re an external user, and are 

not using the INDOT Standalone Workspace, you will not have access to our managed workspace.  As 

such, the INDOT-specific tools, levels, and customizations will not be available to you.   

1.3-1  Managed Workspace Export 
The managed workspace attaches itself to any document opened by a MicroStation based application 

(MicroStation, OpenRoads Designer, etc.) from within ProjectWise.  You can expect the managed 

workspace to be active when viewing/editing DGNs, DWGs, DXFs or any other file ProjectWise opens 

with a MicroStation based application such as OpenRoads Designer. 

When opening CAD files from ProjectWise for the first time, you will see the following. 

 
Managed Workspace Export Dialog 

This is the Managed Workspace Export Progress dialog, and it shows the status of ProjectWise placing 

the workspace in your working folders.  The first time you open a CAD file after the workspace has been 

initialized, this dialog will take a short amount of time to download all the relevant files and configure 

your workstation for the first time. 

Subsequent file opens will reduce the amount of time required for the export to complete—as once the 

files have been downloaded, ProjectWise will only update them if there has been a change at the server.  

This ensures that you always have the most up-to-date workspace files available. 
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1.3-2  Working with the Workspace 
Day-to-day use of the workspace has not changed in a visible manner.  All toolboxes, macros, and 

symbology resources have been updated to automatically be available when you access your files.  

Areas where you may see differences are in the file paths where items such as cells are being attached 

from, or where you are initially directed to attach other resources. 

1.3-3  INDOT Customized Fonts 
With the release of MicroStation V8i, Bentley no longer provides a method of maintaining and further 

customizing font resource files.  Due to this limitation, INDOT customized fonts have been discontinued 

and we have instead moved to using true type fonts only.  The benefits of this method are that files will 

seamlessly translate between CAD packages, and this will prevent the various other issues such as text 

rendering improperly or with the wrong character set. 

As such, the Office of Standards and Policy has provided CAD tech notes on how the special character 

cells that have been instituted as their replacement should be used in conjunction with the True Type 

fonts. 

1.3-4  MicroStation and Files with SignCAD Fonts 
With the removal of the legacy INDOT font resource file, the managed workspace is now configured to 

have the SignCAD fonts available on every project as there is no longer a conflict with existing resources. 

1.3-5  The MicroStation Platform, File -> Open and Workspace Reloads 
When opening files from the File -> Open command in a MicroStation platform product, you may be 

prompted with the following dialog: 

 
Managed Workspace Prompt when Switching Files 

This dialog denotes that there is a difference between the workspace you currently have loaded and the 

workspace options for the file you are attempting to open (most commonly a file based, reference path 

will change).  In most instances the user can safely select No to proceed to their next file as most files 

now share the same workspace.  One should consider selecting Yes, however, if they are switching from 

a MicroStation to an InRoads associated file.  This would be necessary so that the appropriate civil 

resources are loaded for these legacy file types and their associated operations. 

1.3-6  Text Styles 
This section will give an introductory description of what a MicroStation-based text style comprises, and 

then will cover the text styles that are currently included in the INDOT managed workspace. 
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1.3-6a What is a Text Style? 

MicroStation supports text styles and provides an interface for constructing text using available system 

fonts and a wide variety of text attributes. A text style comprises a group of text attributes, such as font 

type, width, height, and color. Text styles enable you to place text within a model in a consistent and 

automated manner. 

The following fonts are supported natively in MicroStation: 

• Traditional MicroStation fonts 

• TrueType fonts 

• AutoCAD Shape fonts (.shx)  

Tip1.  Fonts are not embedded in the DGN file.  

Tip2.  If a Text Style changes in a Text Style library, Text Styles placed in DGN files prior to the change are 

not automatically updated in the DGN files. To update a DGN file to reflect the changes in the Text Style 

library, use the dgnlib to Update from Library from the text styles dialog. 
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1.3-6b INDOT Text Styles 

INDOT has standardized the use of Tahoma font as the primary font used, except in limited 

circumstances.  You will notice that the text styles are now using only True Type fonts—which gives us 

more flexibility with the Bold and Italics settings.  The Bentley fonts will only be provided where 

necessary and will not be available for new projects.  The following tables will show you the base 

settings for each text style provided as part of the INDOT Workspace. 

Text Style Name Font 
Height 

(in.) 

Width 

(in.) 
Notes/Guidelines for Use 

Text Styles for D-Size Plan Sheets 

10 Point Text Tahoma 0.10 0.10 May be used for table data. 

10 Point Text 
(Survey Text) 

Arial Narrow 0.10 0.10 
(Color 225) 
Use for selected survey text. 

12 Point Text Tahoma 0.12 0.12 

Use for text callouts, dimensions, and 
notes.  Minimum size for text placed on D-
size plans other than text specified under 
10 Point Text. 

14 Point Text Tahoma 0.14 0.14 
Use for selected text on title block, view 
subtitles, and column headings in tables. 

14 Point Text 
(Property Owners) 

Bookman Old 
Style 

0.14 0.14 Use for parcel-owner text only. 

18 Point Text Tahoma 0.18 0.18 
Use for detail and section titles, and table 
titles on detail sheets. 

30 Point Text Tahoma 0.30 0.30 Use for selected text on title sheet of plans. 

GIS Annotation – 
Full Size 

Tahoma 30 30 
Used for annotation of GIS Required 
elements and provided for legacy 
compatibility. 

Text Styles for Ltr-Size Plan Sheets 

5 Point Text Tahoma 0.05 0.05  

6 Point Text Tahoma 0.06 0.06 
May be used for table data, existing-grade 
elevations on grid of plan and profile view, 
and selected survey text. 

7 Point Text Tahoma 0.07 0.07 
Use for selected text on title block. 
Column headings in tables, and parcel-
owner text. 

7 Point Text 
(Survey Text) 

Arial Narrow 0.07 0.07 
(Color 222) 
Use for selected survey text. 

9 Point Text Tahoma 0.09 0.09 

Use for text callouts, dimensions, notes, 
column headings in tables, and parcel-
owner text.  Minimum size for all text 
placed on letter-size plans, other than text 
specified under 6 Point Text. 

12 Point Text Tahoma 0.12 0.12 Use for selected text on title sheet of plans. 

14 Point Text Tahoma 0.14 0.14 
Use for detail and section titles, and table 
titles on detail sheets. 

INDOT Text Styles 
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NOTES: 

1. All styles are set to 0.65 (exact) line spacing. 

2. All styles are Center-Center justified initially.  Exceptions may exist for specific processes and are 

listed in parentheses such as (LT) – Left Top, (LB) Left Bottom, etc.  

3. All styles are non-bold and non-italic and should remain so unless indicated otherwise above. 

4. Variations of the 10 Point, 12 Point, and 14 Point Text styles have been created from their base 

text styles for use in annotation groups and/or civil labels. 

(Values in the preceding chart are representative of a 1 to 1 scale) 

There are additional styles provided from the Bentley default configuration.  These named styles come 

from other application sources and are not used in the INDOT workflow and should not be removed as 

they are used as part of other default application configurations. 

1.3-7  Dimension Styles and Settings 
MicroStation dimension styles allow you to save dimension settings by name.  This allows for greater 

unity between groups of dimensions in the file, as several different styles can be used for various models 

or portions of a model.  Dimension styles are managed through the Dimension Styles Settings dialog 

box. 

 

Dimension Styles 
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These dimension styles relate to the size of the text and are linked to the appropriate text style.  The 

following tables will show you the settings for each dimension style that is used in the plans production 

process.  Note: Values in the chart below are representative of a 1 to 1 scale. 

Dimension Style Name Text Style Units Notes / Settings 

Dimension Styles for D-Size Plan Sheets 

Arch 12 Point Text 
MU label-SU label, 
round to nearest 1/16 

Arrow terminator, 
no text frame 

Arch_Struc 30 Point Text 
MU label-SU label, 
round to nearest 1/16 

Arrow terminator, 
no text frame 

Engr Arrow 12 Point Text 
MU label,  
round to nearest 0.01 

Arrow terminator, 
no text frame 

Engr Arrow Civil Labeler 12 Point Text 
MU label, round to 
nearest 0.01 

Variation of Engr Arrow; used 
in civil labels. 

Engr Arrow Line 12 Point Text 
MU label,  
round to nearest 0.01 

Arrow terminator, 
line text frame 

Engr Circle 12 Point Text 
MU label,  
round to nearest 0.01 

Circle terminator, 
no text frame 

Engr Circle Civil Labeler 12 Point Text 
MU label, round to 
nearest 0.01 

Variation of Engr Circle; used in 
civil labels 

Engr Circle Line 12 Point Text 
MU label,  
round to nearest 0.01 

Circle terminator, 
no text frame 

Engr None 12 Point Text 
MU label,  
round to nearest 0.01 

No terminator, 
no text frame 

GIS Notation 
GIS 
Annotation – 
Full Size 

MU label,  
round to nearest 0.01 

Arrow terminator, 
no text frame 

Dimension Styles for Ltr-Size Plan Sheets 

Arch Ltr 9 Point Text 
MU label-SU label, 
round to nearest 1/16 

Arrow terminator, 
no text frame 

Engr Arrow Ltr 9 Point Text 
MU label,  
round to nearest 0.01 

Arrow terminator, 
no text frame 

Engr Arrow Line Ltr 9 Point Text 
MU label,  
round to nearest 0.01 

Arrow terminator, 
line text frame 

Engr Circle Ltr 9 Point Text 
MU label,  
round to nearest 0.01 

Circle terminator, 
no text frame 

Engr Circle Line Ltr 9 Point Text 
MU label,  
round to nearest 0.01 

Circle terminator, 
no text frame 

Engr None Ltr 9 Point Text 
MU label,  
round to nearest 0.01 

No terminator, 
no text frame 

NOTES: 

1. All styles are set to use Working Units. 

2. All styles are set to Dynamic Justify text notes. 

3. There are additional styles available for other functionality such as civil labels.  These are for 

specific functionality and should not be used outside their specific areas. 
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1.3-8  Levels 
In the current INDOT CAD production workspace, there are over 1250 levels.  Due to this large number 

of levels, level filters can be used to limit the level list ton only those levels needed.  This section will 

cover how the levels are categorized, and then how to create level filters based on these categories. 

1.3-8a Level Classifications 

With the large number of levels that now exist in the INDOT CAD Workspace, a level naming scheme has 

been created to assist in filter creation—in addition to providing for consistent creation and 

categorization of levels. 

Example: P_RDWY_Guardrail 

• P_ - First Position Prefix, indicates that the level contains information related to Proposed work 

• RDWY_ - Second Position Prefix, indicates that the level contains information related to 
Roadway Features 

• Guardrail - Brief Description, indicates that the level contains line work specifically related to 
Guardrail 
 

The table on the following page lists the level classifications that are currently in use in our workspace: 
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First Position Description Second Position Description 

G_ Ground Surface SURF_ Surface Features 

P_ Proposed EW_ Earthworks Features 

RW_ Right of Way HY_ Hydraulics Feature 

S_ Survey (TOPO) RDWY_ Roadway Feature 

XS_ Cross Section ALG_ Alignment 

CG_ COGO Points BR_ Bridge Features 

PROF_ Profile Features CTRL_ Survey Control 

ST_ Standards Drawings DR_ Drainage Features 

PP_ Plans Production PROP_ Property Features 

BD_ Border RW_ Right of Way 

E_ 

Existing Features (non-

Survey) TOPO_ Topographical Features 

CC_ Construction TRAF_ Traffic Features 

XT_ Cross Section Template UTIL_ Utility Features 

Draft_ Drafting Elements G_ Graphical Feature 

Drain_ Drainage Elements TC_ Template Component 

HY_ Hydraulics Features E_ Existing Feature 

Road_ Roadway Barrier Elements OBJT_ Object (Standards Only) 

  ANNO_ Annotation (Standards Only) 

  REFR_ Reference (Standards Only) 

  TTLB_ Title Block (Standards Only) 

  TXT_ Text 

  SHT_ Sheet 

  TL_ Template Library 

  EC_ Erosion Control 

  PVMT_ Pavement 

  ENV_ Environmental Feature 

  MD_ Modeling 

 

Level Classifications in INDOT CAD Workspace 
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1.3-8b Level Filters 

Filters are a useful way to group associated levels for the purposes of viewing or not viewing as a group. 

For example, you might have a DGN file with several hundred levels.  Within these levels could be filters 

for different disciplines such as Bridge and Traffic.  Within Bridge there might be levels for proposed or 

existing elements.  You could easily define a filter called Bridge that would show only levels that would 

be associated with Bridge work. 

Filters can be named, saved, and recalled as needed or defined on-the-fly for immediate one-time 

viewing using the Filter Row in the Level Manager dialog box.  Filters can be turned on or off using the 

Level Display dialog box.  Filters can be used to turn on or off levels across a model and all its attached 

models.  

Levels can be filtered by several attributes such as filename, color, style, line weight, and level groups, to 

name a few.  To display the levels that are defined in a filter, select the Active Level filter button from 

the Attributes toolbar and select the filter of choice.  This will display those levels only and turn off all 

other levels in the dgn.  Note that the levels will not actually be turned on or off, but the ability to view 

them in the Level Display will be dictated by the filter selected.   

An updated set of level filters is available for use within the CAD Workspace.  The table on the following 

page explains the qualifications for these filters: 
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Filter Name Description 

_IN Bridge Level name contains _BR_ 

Bridge - Existing Level name starts with S_BR_ or E_BR_ 

Bridge - Proposed Level name starts with P_BR_ 

_IN COGO Level name starts with CG_ 

_IN Cross Section Components Level name starts with XS_TC_ 

_IN Drainage Level name contains _DR_ 

Drainage - Existing Level name starts with S_DR_ or E_DR_ 

Drainage – Hydraulics Level name starts with HY_DR_ 

Drainage - Proposed Level name starts with P_DR_ 

_IN Erosion Control Level name contains _EC_ 

Erosion Control Proposed Level name starts with P_EC_ 

_IN Rehab Custom Level filter as specified by Bridge Rehab 

_IN Right of Way Level name contains RW_ 

Right of Way - Existing Level name starts with S_RW_ or E_RW_ 

Right of Way - Proposed Level name starts with RW_ 

_IN Roadway Level name contains _RDWY_ 

Roadway - Existing Level name starts with S_RDWY_ or E_RDWY_ 

Roadway - Proposed Level name starts with P_RDWY_ 

_IN Sheet Component Level name contains BD_, PP_, XS_G_ 

Sheet Component - Border Level name contains BD_ 

Sheet Component – Cross Section Level name contains XS_G_ 

Sheet Component – Plans Production Level name contains PP_ 

_IN Standards Level name starts with ST_ 

_IN Survey Level name starts with S_ 

Survey - Bridge Level name starts with S_BR_ 

Survey - Drainage Level name starts with S_DR_ 

Survey - Property Level name starts with S_PROP_ 

Survey - Right of Way Level name starts with S_RW_ 

Survey - Roadway Level name starts with S_RDWY_ 

Survey - Surface Level name starts with S_SURF_ 

Survey - Survey Control Level name starts with S_CTRL_ 

Survey - TOPO Level name starts with S_TOPO_ 

Survey - Traffic Level name starts with S_TRAF_ 

Survey - Utilities Level name starts with S_UTIL_ 

_IN Text Levels Level names contain TXT, Text 

_IN Traffic Level names contain _TRAF_ 

Traffic – Existing Level names start with E_TRAF_ or S_TRAF_ 

Traffic – Proposed  Level names start with P_TRAF_  

_IN Triangulation and Contours Level name starts with G_SURF_ 

 

Level Filters in INDOT CAD Workspace 
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1.3-9  Worksets 
Starting with the INDOTWise 5.1 Workspace, all projects configured for the MicroStation/OpenRoads 

Designer 2023 platform in ProjectWise will now have access to a per-project INDOT_WS workset 

definition.  Instituting this functionality will allow for users to add items such as sheet indexing on a per-

project basis, along with the ability to add per-project customizations into their structure for use.  Sheet 

indexing will be discussed in a following section, and users wishing to add per-project customizations 

should discuss this process with INDOT CAD Support before proceeding.  End user intervention will not 

be necessary to enable the workset functionality, as it will be applied at the creation of each project. 
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2. MicroStation CONNECT Platform 
The following materials cover what is new in the MicroStation CONNECT Platform.  For most agency 

users, OpenRoads Designer will be the product that provides the MicroStation Platform, and the 

following information will apply across that product as well as others such as OpenCities Map Power 

View.  As this discussion covers the common components and interface updates from MicroStation, 

these will be referred to as the MicroStation Platform.  For a more in depth discussion of the changes to 

the UI and its functionality, please refer to the Bentley Learning Path: QuickStart for MicroStation 

CONNECT. 

2.1 What’s Different in the MicroStation CONNECT Platform 

The current MicroStation platform has introduced many changes to the user interface compared to 

previous versions.  The goal of this chapter is to provide you with a guide to these interface changes and 

some of the options that you will see. 

2.1-1  Workflows 
At the top left of the interface, there is a Workflow dialog.  This dialog essentially replaces the Tasks 

dialog that existed in previous versions.  Each workflow contains all the necessary tools that are needed 

to perform the functions it is created for.  This section will cover the general layout of a workflow, and 

some of the UI functionality.  Following this will be a discussion of the custom INDOT Workflow agency 

specific settings and tools. 

 

 

Drawing Workflow (all MicroStation Platform Products) 

In the default setup of the INDOT Workspace, different workflows are visible depending on the product 

that is currently in use.  The list on the following page names each workflow, and the application(s) it is 

associated with: 

  

https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=109567&aftkn=1475aceb-a027-4acc-af03-6f8771aa2130
https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=109567&aftkn=1475aceb-a027-4acc-af03-6f8771aa2130
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Workflow Available in MicroStation Available in OpenRoads Designer 

OpenRoads Modeling  x 

OpenRoads Drawing Production  x 

Survey  x 

Geotechnical  x 

Geospatial Context x x 

Reality Modeling x x 

Drawing x x 

General x  

Task Navigation x  

Modeling (3D files only) x x 

Visualization (3D files only) x x 

SignCAD (if installed) x x 

Drainage and Utilities  x 

INDOT Tools x x 

 

Workflow Availability  

2.1-1a Workflow Layout 

Each workflow consists of a group of tabs in the Ribbon (like the Microsoft Office user interface) that 

summarize the tasks needed to perform the workflow.  Then, each tab contains “Groups” of tools that 

perform those tasks.  For example, to create a new corridor using OpenRoads Designer, the user would 

navigate to the OpenRoads Modeling workflow, then the Corridors tab, and then the New Corridor tool 

in the Create Group. 

 
OpenRoads Modeling Workflow > Corridors tab > New Corridor 

To assist with finding tools in this new interface, it is suggested to utilize the Search field in the top right 

of the application window. As an example, say a user wants to search for where the tool is for creating a 

terrain model from a file.  The term “terrain” can be entered into the Search field, and the search results 

will produce all the tools that have “terrain” in its name.  Then to take it a step further, if the mouse 

pointer is hovered over the search result, a list of navigation paths will appear that will—when clicked 

on—take the user to the workflow where the tool resides and pre-select the tab where it resides. 
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Searching for Tools in OpenRoads Designer 

As shown above, tools can often be found in more than one location, as certain tabs/tools are applicable 

to more than one workflow—such as the Drawing and Drawing Production tabs, which are present in 

several of the workflows. 

Tool Dropdown Menus 

Several tools in the MicroStation Platform interface have dropdown arrows adjacent to them—and 

clicking on them will produce a menu showing various options.  Below is an example of what happens 

when the dropdown arrow adjacent to the Attach Tools button in the Primary Group is clicked: 

 
Attach Tools Dropdown 

Be aware that some tools may just have a corresponding flyout menu associated with them, while 

others—such as the Attach Tools dropdown shown above—have secondary tools listed in them. 
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2.1-1b INDOT Tools Workflow 

The INDOT Tools workflow contains INDOT-specific tools that are specific to our workspace.  From this 

workflow, users can launch the AutoTurn application, add title block integration, connect to our cell 

libraries, among many other tasks. 

 

INDOT Tools Workflow 

Each entry in the ribbon will be discussed in the following sections.  What you will find is a mix of tools, 

preconfigured settings, and utility launchers that correspond to several functions specific to the INDOT 

CAD Workspace. 

Applications & Tools 

 

 
The Applications & Tools Ribbon 

On the Applications & Tools ribbon you can find a series of small tools and launchers for the following: 

• Run Change Direction Tool – Used to change the direction of base MicroStation Platform 

elements, this should not be run on elements created with any Civil data such as alignments, 

there are dedicated tools for these functions where necessary. 

• Launch AutoTurn – Used to launch the AutoTurn turning radius application that runs within the 

MicroStation Platform.   

NOTE: There are a couple important items to keep in mind when launching AutoTurn.  First, to launch 

AutoTurn, you MUST first be connected to the state network (in office or via VPN if remote) to connect to 

our AutoTurn licensing.  If you are not connected to the state network, you will receive an error message 

indicating that the application was not able to obtain the necessary licensing.  Second, once AutoTurn is 
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successfully launched, you must then go to the Drawing workflow, where you will find the AutoTurn tab 

containing the AutoTurn tools. 

 

AutoTURN Tab in Drawing Workflow 

• Title Block Integration Cell – Used to directly attach the cell library for the cells used for title 

block tags.  This should only be used in conjunction with the CAD Support team as multiple 

placements of these cells can cause issues when title block text is resolved from ProjectWise. 

• Title Block Update – Used to update the title block of plan sheets with the latest project 

attributes pulled from ProjectWise. 

• LineStyle Re-Import – Used to re-import line styles from our source RSC file that have become 

corrupted in your current file. 

• Show Civil Schema Info – Used to display the civil schema information for the ORD application 

you’re working with. 

Cells 

 

The Cells Ribbon 

On the cells ribbon, you can find the following cell related options: 

• Place Cell Tool – Launches the MicroStation Platform Place Cell dialog with the currently active 

cell library. 

• Set Active Scale=1 – Sets the active scale for the current model to 1 for the X,Y, an Z coordinates.  

All cell placement relies on these scales, and this allows to quickly reset depending on need. 

• Country District Maps – Attaches the county and district map library for use on title sheets. 

• Imperial Detail Cells – Legacy design detail cells in imperial units.  Note that these are provided 

as reference from prior versions of the CAD workspace and elements/styles may not adhere to 

current workspace conventions. 
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• Metric Detail Cells – Legacy design detail cells in metric units.  Note that these are provided as 

reference from prior versions of the CAD workspace and elements/styles may not adhere to 

current workspace conventions. 

• Lighting Cells – Cells primarily used for sign, signals, and lighting plans. 

• Patterns Cells – Basic pattern cells used for filled shapes. 

• Pavement Markings Cells – Cells used to place pavement markings. 

• Signs Cells – Cell libraries of agency signage used to place signs without necessitating the usage 

of SignCAD.  A dropdown menu of the various libraries is available to attach specific categories. 

 

Signs Cells Dropdown Menu 

• Symbol Cells – Common drafting symbols 

• Scale Bars – A variety of preconfigured scale bars. 

• Tables-Legends-Notes Cells – Mixed text/table components created for placement on CAD 

drawings. 

• MOT Cells – Maintenance of Traffic cells 

• Professional Stamps – Agency PE stamps for quick placement.  Agency users only. 

Annotation Tools 

 
The Annotation Tools Ribbon 
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The Annotation Tools ribbon contains the following items: 

• Place Text Along – Allows for the placement of text along a MicroStation Platform adjusting its 

orientation to follow the element path. 

• Change Case – Quickly change the case of already placed text. 

• Align Elements By Edge – Allows for the alignment of multiple CAD elements to align to another 

existing element.  Commonly use with items such as station offset annotations to align text to 

the border frame. 

• Annotation Styles Letter and Full Size – These are a series of prebuilt annotations using the place 

note and place text tools using workspace text styles, dimension styles, and symbology. 

  
Letter Size and Full Size Dropdown Menus 

• Benching Table Cell – Places the optional Benching Table Cell on End Area Volume Tables on 

Cross Sections. 
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Survey 

 
The Survey Ribbon 

The following can be found on the Survey ribbon: 

• Place Line, Text and Note – These are the base MicroStation Platform commands placed for 

quick access. 

• Graphic Scale – Survey specific scale bar cells. 

• Survey Topo Symbols – Cell library containing survey TOPO symbols for manual placement. 

• Survey Monuments - Cell library containing survey monument symbols for manual placement. 

• LS Stamps - Agency LS stamps for quick placement.  Agency users only. 

• Survey Cells – Survey sheet and reference card components for placement as cells. 

Traffic 

 
The Traffic Ribbon 

In the Traffic Ribbon you can find the following items: 

• Lighting Library – Cells specific to lighting operations. 

• Signals Library – Cells specific to signals operations. 

• Signs – Signage cell libraries, please see the earlier section on Cells ribbon for more detail. 

• Pavement Markings Library – Cells used to place pavement markings. 

• Symbol Cells – Common drafting symbols 

• Tables-Legends-Notes Cells – Mixed text/table components created for placement on CAD 

drawings. 



 
27 

• Launch AutoTurn – Used to launch the AutoTurn turning radius application that runs within the 

MicroStation Platform.   

NOTE: There are a couple important items to keep in mind when launching AutoTurn.  First, in order to 

launch AutoTurn, you MUST first be connected to the state network to connect to our AutoTurn licensing.  

If you are not connected to the state network, you will receive an error message indicating that the 

application was not able to obtain the necessary licensing.  Second, once AutoTurn is successfully 

launched, you must then go to the Drawing workflow, where you will find the AutoTURN tab containing 

the AutoTurn tools. 

 

AutoTURN Tab in Drawing Workflow 
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2.1-1c The OpenRoads SignCAD Workflow 

The OpenRoads SignCAD workflow allows users to import and paste SignCAD sign files (.sgn) within the 

MicroStation Platform.  Of particular interest in this workflow is the SignCAD tab, which contains two 

commands: Import SignCAD File and Paste SignCAD File.  These commands are explained below. 

 

The OpenRoads SignCAD Workflow 

• Import SignCAD File – Allows the import of existing SignCAD files (.sgn) into the MicroStation 

Platform. 

• Paste SignCAD File – Configures the settings for placement of sign files copied directly from the 

OpenRoads SignCAD application. 

2.1-1d OpenRoads Workflows 

For a discussion of the additional workflows that are made available in OpenRoads Designer, please 

refer to the DOTWise 5.0 ORD Plans Production Documentation which covers these tools along with 

their usage. 

2.1-2  Customizing the Ribbon Display 
The Ribbon in the MicroStation Platform can be customized in several ways.  One way to accomplish this 

is to right-click anywhere within a Ribbon Group, which presents a menu with several options to 

customize its display.  The second way is to directly access the Customize Ribbon dialog, which is 

discussed at the end of the section. 
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2.1-2a Customizing the Tools Displayed in a Ribbon Group 

The top section of the Ribbon Group’s menu lists all the tools that are associated with it. 

 
Ribbon Group Tools 

In the above example, a right-click within the Primary Ribbon Group presents a menu as shown.  The 

tools listed with a check mark next to them are already being displayed.  As such, the tool display in the 

Group can be turned on and off as desired. 
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2.1-2b Customizing the Display of Ribbon Groups 

The Pin/Unpin Group option allows the user to pin (display) a Group in either a) every tab in all 

workflows, or b) every tab in just the current workflow. 

 
Pinning a Group to Workflows 

Note that when a Group is pinned, it is placed on the left side of the Ribbon for each tab.  Also note the 

icon indicating that is pinned. 

 
Pinned Group 

To unpin the Group, the user can either click on the icon as shown above or selecting the Unpin option 

in the Ribbon Group’s menu. 
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2.1-2c Customizing Button Sizes 

To customize the button sizes in a Ribbon Group, navigate to the Group Button Size option in the Ribbon 

Group’s menu and select the desired size: Small, Medium, or Large.  To bring the sizes back to their 

defaults, select the “Revert to default” option. 

 
Customizing Button Size in a Ribbon Group 

2.1-2d The Customize Ribbon Dialog 

Selecting Customize Ribbon from the Ribbon Group’s menu will open the Customize Ribbon dialog. 

 
Customize Ribbon Dialog 

NOTE: This can also be accessed by clicking on the File tab in the Ribbon and then clicking on Settings > 

User > Customize Ribbon button. 
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From the Customize Ribbon dialog, a user can customize their Ribbon display by adding and/or removing 

components (Ribbon Groups, tabs, individual buttons, etc.) to/from it.  To add a component to the user 

interface, the component first needs to be selected in the “Choose components from:” section of the 

dialog.  Then that component needs to be brought over to the desired location in the “Customize the 

Ribbon:” section via click and drag.  In the example below, the Analysis tab is being brought into the 

INDOT Tools workflow. 

 
Adding a Tab to a Workflow via Customize Ribbon Dialog 

Once added, the INDOT Tools workflow and the Analysis tab both have a (Pending) designation in the 

Customize the Ribbon section.   

 
Pending Changes in Customize Ribbon Dialog 
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This is indicating that the changes being proposed are still pending.  Click on the Apply button to confirm 

the changes.  After completion of processing, the Analysis tab is now added to the INDOT Tools 

workflow. 

 

Analysis Tab Added to INDOT Tools Workflow 

2.1-3  Customizing the Quick Access Toolbar 
In much the same way as for the Ribbon, the Quick Access Toolbar—located next to the Workflow 

dialog—can also be customized. 

 
Quick Access Toolbar 

Clicking on the button on the far right of the toolbar brings up a menu like that of a Ribbon Group’s 

menu—to where the display of tools/options can be turned on and off as desired.  Options are also 

available to show the toolbar below the Ribbon, or to minimize the Ribbon entirely. 
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Quick Access Toolbar Menu 

2.1-4  Dockable Dialogs 
To gain more screen space, there are many dialogs that you can dock to the edges of the MicroStation 

platform application window.  

2.1-4a To Dock a Dockable Dialog 

1. Select a dockable dialog's title bar.  Most dialogs in the MicroStation platform can be docked, 

and if they are able to, docking indicators like the below example will be displayed. 

 
Single Docking Indicator (Left) & Full Docking Indicator (Right) 

2. Drag the dialog over one of the docking indicators that appear in the center of the screen or 

along the edges of the application window. 
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3. As soon as you begin to drag a dockable dialog, a transparent block representing the dialog is 

attached to your pointer and moves with the pointer until you release the mouse button. 

4. Place the pointer over one of the docking indicators.  This highlights the available docking region 

along the corresponding edge of the application window. 

 
Bottom Docking Indicator with Possible Docking Region 

5. Release the mouse button.  The dialog is docked within the selected docking region and is 

displayed in its entirety. 

2.1-4b To Turn on Auto Hide for a Docked Dialog 

1. Dock a dockable dialog to an edge of the application window. 

2. Click the Auto Hide (pushpin) icon in the upper-right corner of the docked dialog.  The docked 

dialog disappears, and a roll-out tab appears in its place along the same edge of the application 

window. 
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2.1-4c To Turn off Auto Hide for a Docked Dialog 

1. Place the pointer over a docked dialog's roll-out tab. 

2. While the dialog is displayed, click the Auto Hide icon.  The dialog is re-docked along the same 

edge of the application window.  

 

2.1-4d To Undock or Float a Docked Dialog 

Double-click the title bar of a docked dialog. The dialog returns to the position in which it was last 

floating. 

2.1-4e To Re-dock a Floating Dockable Dialog 

Double-click the title bar of a floating dockable dialog which has been docked at least once. The dialog 

returns to the location where it was last docked. 
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2.1-4f To close a docked dialog 

If the dialog is docked, simply click the dialog's Cancel icon (next to the Auto Hide icon).  If Auto Hide is 

enabled, first pause the pointer over a docked dialog's roll-out tab, then while the dialog is displayed, 

click the dialog's Cancel icon, or simply enter the key-in that is normally used to close the dialog. 

If you close a dialog while it is docked, and later click the icon or enter the key-in that normally opens 

the dialog, the dialog will open again to the position it was last docked. 

If a dialog is docked when MicroStation exits, it will be docked in the same position the next time you 

start the product. 

2.1-4g List of Dockable Dialogs 

The following is the list of dockable dialogs, and which edges they can be docked to: 

• Tool Settings window (left or right) 

• Element Information dialog (left or right) 

• Project Explorer dialog (left or right) 

• Link Sets dialog (left or right) 

• Tasks dialog (left or right) 

• Markups dialog (left, right, top, or bottom) 

• Item browser (left or right) 

• Details dialog (left, right, top, or bottom) 

• Feature Manager dialog (left or right) 

• References dialog (top or bottom) 

• Raster Manager dialog (top or bottom) 

• Models dialog (top or bottom) 

• Saved Views dialog (top or bottom) 

• Level Manager dialog (top or bottom) 

• Level Display dialog (left, right, top, or bottom) 

The way in which you dock one of these dialogs is different from the way in which you dock a toolbox. 
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2.1-4h Using Docking Indicators 

As you drag a dockable dialog, docking indicators appear on the screen. These docking indicators 

indicate which edges of the application window the selected dialog can be docked to. In most cases, a 

dockable dialog can only be docked either horizontally or vertically; however, some dialogs, like the 

Level Display dialog, can be docked both horizontally and vertically. 

 

If the selected dialog can be docked horizontally, then the docking indicator at the center of the screen 

will have arrows that point toward the top and bottom edges of the application window, and matching 

docking indicators appear along the top and bottom edges. If the selected dialog can be docked 

vertically, then the docking indicator at the center of the screen will have arrows that point toward the 

left and right edges of the application window, and matching docking indicators appear along the left 

and right edges. 

 

You can release the dialog over any of these arrows, and the dialog will be docked to the corresponding 

docking region. While it is mostly a matter of preference whether you use the docking indicator at the 

center of the screen or the ones at the edge of the application window, there is a slight difference in the 

two.  

Using the center docking indicators will position the dialog so that it takes up the remaining free space 

along the length of the selected edge of the application window. For example, if there is already a dialog 

that is docked vertically on the left edge of the application window, then dropping a horizontally docking 

dialog over the center docking indicator, pointing toward the top edge of the application window, will 

dock the dialog so that it fits in the remaining space along the top edge. 

Using the docking indicators at the edges of the application window let you decide where specifically 

along the selected edge you want to dock the dialog. For example, if there is already a dialog docked to 

the left edge, you can use the edge docking indicators to select whether you want to dock the new 

dialog on top of the existing dialog, or to the left or right of it, or above or below it.  
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If you are moving a dockable dialog and there are no dockable dialogs currently docked to the edge of 

the application window that the selected dialog can be docked to, then the center controls will not 

display. 

2.1-4i Other Dialogs that can be Docked 

The following dialogs are also dockable; however, their docking behavior follows the standard docking 

behavior for toolboxes: 

• Key-in window 

• View Groups window 

• AccuDraw window 

• Drawing Scale window 

• Snap Mode button bar 

2.1-4j Dialogs that are Docked by Default 

When you start MicroStation for the first time and open a file, certain dockable dialogs are already 

docked. This is because the product delivers a docking preference file that defines which dialogs are 

docked by default, and where they are located.  As you make changes to the location of docked dialogs, 

that information is saved in your personal docking preference file, rather than in the delivered default 

docking preference file. 

2.1-5  The Backstage View (File Menu) 
The CONNECT edition of MicroStation platform products contains a “Backstage View” when the File tab 

is clicked. 

 

File Tab 

This opens the Backstage View (essentially, the File Menu).  The basic functionality within the Backstage 

View is like what was contained within the File menu on previous versions.  Specifically note the options 

on the left side of the view. 
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Backstage View 

The remainder of this section will give a brief synopsis of the functionality contained within the 

Backstage View. 

• New:  Creates a new file either within ProjectWise or on your local PC. 

• Open:  Opens an existing file.  A Browse button is provided at the bottom of the Open dialog to 

aid in browsing to the file you wish to open. 

• Save:  Saves the file. 

• Save As:  Saves the existing file to a different name and/or location. 

• Update Server Copy:  Updates the copy of the file on the ProjectWise server. 

• Save Settings:  Saves the active view settings in the file for when you open it again in the future. 

• Send Mail:  Opens Outlook with a new e-mail that has the current file attached, so that it can be 

sent via e-mail. 
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• Close:  Closes the file. 

• Tools:  Provides some advanced tools to manipulate files.  Of note are the Compress File and 

Compress Options tools to compress the current file’s size, and the Batch Process tool to create 

and run a script to run processes on a group of files. 

 

Tools Dialog 
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• Settings:  Allows you to adjust MicroStation platform settings at the user level, the system (PC) 

level, and the file level.  You can also set up configuration variables if desired. 

o User:  These are settings that can be configured on an individual user level and would 

apply each time the user accesses a MicroStation platform-associated file within the 

managed workspace. 

 

Settings > User Dialog 

o System (PC):  This only contains one setting (Digitizing), which is not applicable for use in 

our managed workspace. 
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o File:  These are settings that are configured and only applicable to the current design 

file. 

 
Settings > File Dialog 

o Configuration:  Allows you to adjust various configuration settings within the 

MicroStation platform.  Of note is the Configuration Variables option, which allows you 

to set up configuration variables. 

 

Settings > Configuration Dialog 

• Properties:  Takes you out of the Backstage View (back into the design file) and opens the 

Properties dialog to display the properties of the file. 
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• Print:  Provides you with various options and settings relating to printing files.  Of note is the 

Print Organizer functionality, which is discussed in detail in Chapter 4. 

 
Print Dialog 

• Import:  Provides you with several options to import file data via various file types. 

 
Import Dialog 
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• Export:  Provides you with several options to export your file data to various file types. 

 
Export Dialog 

• Publish i-model:  Allows you to convert a design file into an I.DGN file and package a set of such 

files.  This i-model functionality is currently not applicable to our workspace but may be 

implemented in the future. 

• Help:  Provides various help resources to guide you with using the platform application. 

• Feedback:  Allows you to provide either positive or negative feedback to Bentley pertaining to 

the currently active product. 

• Exit:  Exits the application. 
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2.1-6  Project Explorer – Links 
The Links tab provides you with several external links to web sites to assist you with working with the 

MicroStation Platform and other INDOT-CAD Resources for OpenRoads Designer.  Of note are the links 

listed under Bentley LEARN and INDOT. 

 
Links Tab 

NOTE: The Links tab is not enabled for display by default.  To have it displayed, you will need to go into 

the File menu (Backstage View) per the following instructions: 

1.  With a file open in the MicroStation Platform, click on the File tab to access the Backstage View. 
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File Tab 

2. In the Backstage View, click on Settings > Explorer Settings. 

   

 

Explorer Settings 

3. In the Explorer Settings dialog, locate the Links section and change the Visible setting to Yes.  

Click OK when done.   The Links tab will now be displayed in Project Explorer. 
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Visible Setting for Links Tab 

2.1-7  INDOT_WS Workset and Sheet Indexing 
As previously mentioned, all projects created after the release of the INDOTWise 5.1 Workspace will 

automatically have an INDOT_WS workset defined for the project and users will be able to now start 

using sheet indexing in the 2023 versions of MicroStation/OpenRoads Designer.  This section will give a 

brief overview of sheet indexing and how to manually add/remove sheets.  Further discussion can be 

found in the INDOTWise 5.1 ORD Plans Production document as it pertains to cutting various sheet 

types, and then in the INDOTWise 5.1 Plotting document for discussion on how to use a Sheet Index to 

generate a plot set. 

2.1-7a The Sheet Index Interface 

The Sheet Index is provided as part of having an active Workset in a project.  It allows for the user to add 

sheets to the Index for quick access to various sheets, sheet categorization, and to send to a plot set.  In 

this initial release, sheet index settings are being driven by the application defaults and can be adjusted 

upon user request for our templates moving forward. 

The Sheet Index interface is available to all users of a project; however, it should be noted that only one 

user can access the Sheet Index in an editable fashion at a given time.  This is due to the nature of the 

ProjectWise check in/check out process and restrictions it places on file access. 

The Sheet Index can be found as an entry on the Project Explorer and has the following commands on it: 
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Sheet Index (Read Only) 

 
Sheet Index (Read-Write) 

As shown in the previous screen captures, there are two states to the Sheet Index interface.  The Read 

Only version is typically what is presented when opening a file in its default state.  This version presents 

the following tools (From L to R): 

• Refresh – Refreshes the sheet index. 

• Place sheet index as a table – Not currently customized, can be used with default settings. 

• Open Print Organizer – Opens Print Organizer with all sheets in the index automatically added to 

the set.  This is discussed further in the INDOTWise 5.1 Plotting document. 

• Open Sheet Index for Edit – Makes the sheet index editable to add sheets, adjust settings, etc. 

• Transparent – No function on this panel. 

• Zoom – No function on this panel. 

• Isolate – No function on this panel. 

When the Open Sheet Index for Edit button is selected, the workset file will be checked out, and the 

following commands will be shown in the Read-Write format (From L to R): 

• Refresh – Refreshes the sheet index. 

• Place sheet index as a table – Not currently customized, can be used with default settings. 

• Open Print Organizer – Opens Prin Organizer with all sheets in the index automatically added to 

the set.  This is discussed further in the INDOTWise 5.1 Plotting document. 
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• Make Sheet Index Read Only – This replaces the Open Sheet Index button, and when selected 

will check the Sheet Index workset file back into ProjectWise. 

• Add Sheet/Folder – Used to add sheets to the index.  If add folder is selected, additional folders 

can be added to the index for file classification. 

• Manage Sheet Index – Allows for the customization of the sheet index configuration, such as 

sheet prefixes/suffixes, automatic numbering and incrementing, etc. 

• Update All Sheet Properties – Updates any document properties that pull from workset values.  

Not necessarily applicable in our current ProjectWise environment as we facilitate sheet 

numbering and other document properties through either the design script or ProjectWise 

interface properties. 

• Show Modified – Any sheets with differences from the workset values will be highlighted in 

blue.  Not currently applicable in our ProjectWise environment as workset properties are not 

being used to populate file content. 

• Delete – Only available if a Document/Folder in the index is selected.  Removes the selected 

entry from the index. 

• Transparent – No function on this panel. 

• Zoom – No function on this panel. 

• Isolate – No function on this panel. 

In the following sections, we will cover some of these commands and their potential usage in our 

workflow.  Please consider this a starting point for the functionality of the toolset and reach out to your 

CAD Peer Group members with suggestions for consideration. 

 

 

 

2.1-7b Opening the Sheet Index for Editing 

As already noted, an INDOT_WS workset and sheet index will be provided by the project creator for all 

INDOTWise 5.1 Workspace projects.  To open this file for customization and editing, simply enter a CAD 

file in the project, and in the Project Explorer, and select the Sheet Index entry.  On the Sheet Index 

toolbar, then select the Open Sheet Index for Editing button: 
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Open Sheet Index for Editing 

When selected, a brief check out dialog will appear as the index/workset file is checked out.  The toolbar 

will then switch from the Read Only version to the Read-Write version shown previously.   
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2.1-7c Sheet Index Customization 

At this point, customization of the index can be performed, and the settings shown below (accessed via 

the Manage Sheet Index tool) can be modified.  Suggestions for default configurations will be 

appreciated as this is further implemented.  For this example, the following default settings will be used: 

 
Manage Sheet Index 

2.1-7d Adding Folders/Sheets 

With the index in Read-Write mode, users can also add folders and sheets directly to the index.  In this 

example, sample folders will be created and files containing sheets will be added.   

Note: OpenRoads cut sheets can be directly added to the sheet index by enabling the Add to Sheet Index 

setting on the respective Named Boundary tools.  Discussion of this method will be covered in the 

INDOTWise 5.1 ORD Plans Production documentation. 

For the first example, a few new categorization folders will be added to the sheet index for different 

sheet types.  With INDOT_WS selected, pick the Add > New Folder button and add a folder: 

 
Add a New Folder 



 
53 

 
Sample Folders Created 

Note that these folders can be re-arranged in any manner simply by dragging and dropping them with 

the Sheet Index in Read-Write mode.  This allows for the index to be configured with the sheets in the 

order they would potentially be accessed or for plotting purposes. 

Note: The following method to add sheets via the Sheet Index > Add Sheet has a bug in OpenRoads 

Designer 2023 which has been acknowledged by Bentley.  Attempting to add sheets via this method will 

result in the following error. 

 
Adding Sheets Error 

Please review the alternate drag and drop method at the end of this section.  The following information 

is being preserved for use in later versions where this bug has been resolved. 

With these folders created, sheets can now be added.  The following example will show adding sheets 

that were previously cut in OpenRoads Designer, but not added directly to the index.  In this instance, 

Plan Profiles will be added.  To start, the Plan Profile folder will be selected, followed by the Add > Add 

Sheet button: 
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Add Sheet 

In the presented ProjectWise dialog, navigate to the file(s) to add.  When completed, the dialog will 

proceed to add any sheets in the files selected to the selected folder in the index. 

 
Sheets Added to Index 

With the files in the index, users can then navigate to them directly through this interface.  

In addition to the preceding process, users may also drag and drop sheet models directly from the 

Models dialog into the sheet index to add them.  To complete this method, enter the DGN that contains 

the models you’d like to add.  Select the appropriate models on the models dialog and drag and drop 

them onto the sheet index.  While processing, a brief progress dialog will display the progress of the 

process.  Note that this process will need to be completed for each DGN containing sheet models in the 

project. 
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Drag and Drop into Index 

When complete, the index will reflect the new sheets added. 

 
Sheets Added via Drag and Drop 

With folders and sheets added, the order can then be manipulated simply by dragging and dropping the 

sheets/folders in the desired order.  Setting this order is important, as it will determine the inital sheet 

order and organization if the sheet index is used at the basis for a Print Organizer set. 
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2.1-7e Closing the Sheet Index 

At this time, the Sheet Index should be closed to editing by selecting the Make Sheet Index Read Only 

button, and when prompted, checked back into ProjectWise. 

 
Make Sheet Index Read Only 

 

2.2 User Interface Enhancements 

The addition of drag-and-drop support, the ability to customize right-click menus and the Tasks dialog, 

and three new ways to customize the status bar make the interface easier to use. 
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2.2-1  Drag-and-drop Support 
All current MicroStation Platforms contain the ability to drag and drop across several different 

application areas.  The following covers these areas. 

Note:  Not all functionalities will be available when working within ProjectWise. 

 

MicroStation Native Drag and Drop Operations 
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Some of the possible drag and drop operations are: 

• Drag and drop models from the Models dialog to the Project Explorer dialog 

• Drag and drop a saved view from the Saved Views dialog to the Project Explorer dialog 

• Drag and drop files and folders from Windows Explorer to the Project Explorer dialog 

• Drag and drop links from the Project Explorer dialog to a view window 

• Drag and drop links within the Project Explorer dialog 

• Drag and drop saved views from the Saved Views dialog to a view window 

• Drag and drop models from the Models dialog to a view window 

• Drag and drop DGN, DWG, and DGNLIB files from Windows Explorer to the Saved Views dialog 

One common use of the drag and drop feature is between the Models dialog and a view window. 

 
Drag and Drop Functions with Command Modifiers 
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2.2-2  Show/Hide Support in Status Bar 
Right-clicking in the status bar opens a menu allowing you to show or hide sections of the status bar. 

 
Status Bar Options 

2.2-3  Coordinates Display in Status Bar 
Left clicking in the Running Coordinates section of the status bar turns on the coordinates display. As 

you move your cursor, the coordinates of your current position display according to the active Tentative 

Point Mode. When you left click, a menu displays six options. The Delta modes show the X, Y, and Z 

displacement from the last data point. The Distance modes show the distance and direction from the 

last data point. 

 
Coordinate Formats 
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2.2-4  Locks Dialog 
Left-clicking the Locks icon on the Status Bar and then clicking on the expand arrow on the bottom right 

corner of the popup menu opens the Locks dialog.  

 
Locks Dialog and Menu 
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2.2-5  Tool Boxes 
With the ribbon interface in the CONNECT version of the MicroStation Platform, toolboxes aren’t as 

prominent as they were in the V8i version.  However, there are still a number of these tools that users 

may wish to have quickly accessible in all situations regardless of the Workflow on the ribbon.  The 

following discussion will cover how to locate these Tool Boxes, enable them, and make them a direct 

part of the user interface. 

Tool Boxes can be found two different ways in the MicroStation interface.  The first is through the 

Backstage area, located under the File menu.   

 
Use the File Ribbon to Enter the Backstage 

In the Backstage, select the Settings on the left, and then under the displayed Settings, select User.  On 

the right column under User Settings, select the Tool Boxes entry toward the bottom of the display: 
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Tool Boxes Backstage Location 

Alternatively, one can use the Search Ribbon in the upper right corner of the interface to search for Tool 

Boxes and enter the Tool Box selection directly: 

 
Tool Boxes via Ribbon Search 

Both options will open the Tool Boxes dialog where the various tools can be enabled.   
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Tool Boxes 

Some that may be of interest: 

• Drawing Scale – Quick access to the Drawing Scale and working unit tools.  Found in multiple 

locations via the various workflows, these tools are accessed frequently enough to consider 

having docked at all times. 

• Geographic – Tools related to application and usage of Geocoordinate Systems.  Another 

frequently used tool set that is advantageous to having available at all times. 

• AutoTurn-Custom – For users that frequently use AutoTurn, these are the same tools that get 

placed in the Drawing > AutoTurn ribbon when activated.  This tool box is available at all times, 

but please note that the tools will not function unless AutoTurn is started from the INDOT Tools 

workflow. 

2.2-6  User Preference Changes 
With the release of the INDOTWise 5.1 Workspace, INDOT CAD Support has moved the location of 

MicroStation platform preferences to a new location that should be much more user friendly and make 

backing up and restoring user preferences much easier.  This discussion will cover this location and in 

what situations a user might want to interact with the contents of the folder. 

Moving forward with the 2023 MicroStation Platform/OpenRoads Designer 2023, CAD Support has 

migrated the User Preference path to C:\Users\<username>\INDOT ORD Preferences.  <username> 

should be replaced with the username of the active user.  It should also be noted that the user 

preferences are now tagged as “INDOT_<username>_ORD…..” to easily identify that these are specific to 

the INDOT Workspace. 

An example of how this looks can be found below: 
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User Preference Path and Preference Files 

With this path, users can perform the following self-service maintenance operations. 

• Backup of User Preferences – Users can copy this folder and its contents to another location 

once they’ve configured their application interface (tool locations, docking location preferences, 

tool boxes enabled, etc.) to have a clean copy of their preferred settings. 

• Restoration of User Preferences – If users have made a copy of their preferences as previously 

mentioned, they can place the contents back in this location to quickly restore their preferred 

default preferences. 

• One of the first troubleshooting steps that is performed is often to delete user preferences that 

have seemingly been corrupted.  With this location now accessible, users may delete their own 

preferences as an initial troubleshooting step. When performing this operation, all content in 

the folder should be deleted.  As recommended earlier, users can then restore a known good 

backup of their preferences to have the preferred setup restored. 
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2.3 Models Enhancements 

The enhancements to Models include additional viewing capabilities, Project Explorer integration with 

the Models dialog, and sheet name display in the Models dialog. 

2.3-1  View Different Models from the Same File in Each View 
You can view more than one model from the same file in separate views. In the example below, notice 

that the “Multi-models View” view was created and the titles of the two views match two separate 

models in the Models dialog. 

 

Multiple Model Display 

To view different models in each view, first start by opening an additional view from the Manage View 

Groups toolbar.  For this example, open view 2.  Alternatively, you can also open it from the View ribbon 

in most workflows. 
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Manage View Groups 

In view 2, select the View Attributes in the upper left corner of the window.  Locate the View Setup 

controls in the bottom portion of the dialog: 

 
View Attributes and View Setup 

In the View Setup portion of the dialog, you may select either an existing saved view, or one of the 

available models in the file.  Doing so will make it display in the view separate from the primary view 

that was displayed. 
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Selecting a Saved View or Model 

With multiple models displayed in this fashion, the Manage View Groups dialog will now display Multi-

Model Views as the active view.  Note that this can be saved, and alternative views can be configured 

for use. 

 

Note: For the OpenRoads Designer environment, there is a provided series of commands in the View 

Control context menu that will be discussed in that module.  In this environment, it facilitates similar 

functionality with additional enhancements for the civil environment. 

2.4 Text Enhancements 

Text enhancements include the ability to change case by a selection set or fence. The Advanced tab 

allows for comparisons between styles. Word Processor updates include an insert field, subscript and 

superscript icons and right-click operation to change the case. The Edit Text tool retains its text settings, 

and the Find/Replace Text tool supports data fields. 

2.4-1  Change Case by Selection Set or Fence 
This tool is used to change the case of a piece of text. Case change options include Upper Case, Lower 

Case, Title Case, and First Capital. This tool also supports text selection via a fence.  This tool can be 

found in most workflows on the Text Group in the Drawing Production tab.  Click on the dropdown 

arrow in the Group, and then select the Change Case tool. 
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Change Text Case 

2.4-2 Advanced Tab in Text Styles Dialog Allows Comparison Between Styles 
Two new modes (Comparison and Differences) have been added to the Advanced tab of the Text Styles 

dialog. Comparison mode shows a side-by-side comparison of the properties of two selected text styles. 

Differences mode shows the differences of the properties of two selected text styles. 

 

Text Style Comparison 
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Text Style Differences 

2.4-3  Text Editor Enhancements 
Three new icons have been added to the Text Editor dialog. 

The Insert Field icon opens the new Field Type Picker dialog, used to select the type of field to be 

created. See Placeholder fields for more information. 

 
Text Functions 

The Superscript icon allows you to create text with superscript by typing in the text, clicking the 

superscript icon, then typing in the number. The Apply Changes to all Text check box must be toggled off 

to place superscript. 

 
Superscript Text 

The Subscript icon allows you to create text with subscript by typing in the text, clicking the subscript 

icon, then typing in the number. The Apply Changes to all Text check box must be toggled off to place 

subscript. 
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Subscript Text 

2.4-3a Right-click to Change Case 

The Change Case menu items (All Upper, All Lower, Title, and First Capital) have been added to the right-

click menu of the Text Editor dialog. 

2.4-4  Using Fonts 
MicroStation supports three types of fonts: True Type, RSC (MicroStation Resource Font) and SHX 

(AutoCAD Fonts).   

2.4-4a True Type Fonts 

Many TrueType fonts are delivered with Windows, and many more are available from various vendors 

for free or for purchase. TrueType is an industry standard format supported by MicroStation. In general, 

this is the recommended font type for use in MicroStation. TrueType fonts also include full Unicode 

support (note: not all TrueType fonts contain characters for all languages). TrueType fonts are always 

filled, and therefore do not provide good support for “stick” fonts (as opposed to SHX and RSC fonts). 

2.4-4b RSC (MicroStation Resource Font) 

This font format is MicroStation-specific, and RSC fonts are stored in MicroStation resource (.rsc) files. A 

single resource file may contain several RSC fonts. RSC fonts have a number and a name, but only one 

font by a given number can be used at a time during a MicroStation session. If multiple RSC fonts share 

the same number, the last one to be loaded is the font assigned to that number in each session. RSC 

fonts are locale-encoded, but support more than 255 characters (e.g., for some Asian languages). The 

code page of RSC fonts is specified in the font configuration file. If you use font characters for symbols, 

use RSC fonts rather than TrueType fonts.  

Due to various compatibility issues, and lack of customization tools, RSC fonts other than those provided 

with SignCAD, or the MicroStation Platform are no longer available for use in the INDOT Workspace. 

2.4-4c SHX (AutoCAD Fonts) 

MicroStation supports AutoCAD’s font format (including normal SHX fonts, SHX Unifonts, and SHX 

Bigfonts). You should use SHX fonts only when you must ensure AutoCAD compatibility, and TrueType 

fonts are not a viable option. SHX Unifonts are the current standard and allow a single font (and font 

file) to contain characters in the entire Unicode range. Older SHX fonts only support up to 255 

characters, and thus require a paired SHX Bigfont to support languages with more than 255 characters 

(e.g., Asian languages). In MicroStation, specifying a paired SHX Bigfont is optional, and is recommended 

if you require characters that cannot be provided by the base SHX font.  

If AutoCAD is installed, MicroStation searches for SHX fonts in AutoCAD’s Fonts directory (the “Fonts” 

folder in the installation directory of the most recently used version of AutoCAD). With or without 

AutoCAD, MicroStation searches the directories specified by MS_FONTPATH, as well as the same 

directory as the design file requesting the font.  
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DWG Export: AutoCAD natively supports SHX fonts, and no special export is performed. 

2.4-5  Edit Text Tool Retains Text Settings 
In the past, the Edit Text tool would change the active settings whenever you edited a piece of text. This 

behavior has been changed so settings revert to the previous settings when the Edit Text tool is closed. 

This change affects the active settings only and not the text styles. 
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2.4-6  Disabling Text Field Backgrounds 
Various text tools may take advantage of MicroStation fields, tying Model or other properties to a piece 

of text.  Depending on the workflow, it may be desirable to disable the background of the text field for 

use in other applications. 

Starting with MicroStation 2023, the text field background has been moved to the View Attributes for 

each model.  Under the View Attributes locate and disable the Text Field background shown below.  This 

is a per model setting and has been set for INDOT Sheet Seeds used with OpenRoads Designer. 

 
Text Field background 

2.4-7  Special Character Symbols 
The MicroStation Platform has included a true type font style—Engineering Vert—that includes the 

various special character symbols you use to insert in your drawings.  The advantage of this is that you 

no longer need to search through a cell library to find the proper cell that contains the symbol you 

need—it can just be placed directly via the Text Editor.  Simply open the Text Editor and click on the 

Insert Symbol button. 

 

Insert Symbol Button 
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Then on the Symbol Inserter dialog that appears, go to the All Symbols tab and select the Engineering 

Vert font.  With the symbols for the font listed, scroll most of the way down the list and you will find the 

various symbols you might need (flowline, property line, centerline, etc.). 

 

Engineering Vert Special Character Symbols 

Starting with the INDOTWise 5.1 workspace, these symbols are now also being preconfigured as 

favorites for all workspace users and can be located directly under the Favorite Symbols dropdown. 

 
Favorite Symbols 

Note that the preceding process can be used for a variety of symbols and across several fonts.  Not all 

fonts will contain the same symbols, nor will they necessarily be in the same locations.  
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2.4-7a Using Special Character Symbols in Conjunction with INDOT Text Styles 

In most cases, you will want to place a special character symbol in a line/block of text that has an INDOT 

Text Style associated with it.  Considering that the font used for special character symbols (Engineering 

Vert) is different from any of the fonts configured with our INDOT Text Styles, this can create a potential 

conflict.  If you apply an INDOT Text Style to a special character symbol in an existing line/block of text, it 

will turn into a box icon, as shown in the example below: 

    

Special Character Symbol Before and After Applying an INDOT Text Style 

The process to work around this issue is to apply the text style FIRST and then place the symbol within 

the text as specified in the previous section. 

 

Special Character Symbol Placed After Applying an INDOT Text Style 

It should be noted that the size of the symbol that you place will automatically match the font size of the 

selected Text Style. 
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2.5 References Enhancements 

A major enhancement to references is the ability to edit a reference from within the active model.  In 

addition, the active model's annotation scale applies to annotations in references. 

2.5-1  Activate Reference for In-Place Editing 
The MicroStation Platform lets you edit a reference in-place. That is, you can edit a reference from 

within the active model. To do this you first must activate the reference.  

 

Reference Activation 
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When a reference is activated: 

• Only operations on the activated reference are permitted. 

• By default, all elements in references above the activated reference in the file hierarchy, as well 

as the active model, are displayed with an override color. You can control whether an override 

color is used, and what the color is. 

• If you activate another reference, the currently activated reference is automatically deactivated. 

• The reference is locked so that it cannot be edited in another session. 

• DGN library data, such as levels and level filters, is not available in an activated reference file. 

• Activated referenced in InRoads allows for the interaction with underlying civil data such as 

terrains and alignments. 

Note: Activating references should only be used with core MicroStation Platform content.  Elements with 

additional information such as civil content from OpenRoads Designer, or vehicle paths from AutoTurn 

should not be modified via an Activate reference.  Doing so can cause the extended information these 

elements contain to be corrupted or removed resulting in application crashes or lost data. 

2.5-2  References Support Active Model Annotation Scale 
In the past, you may have added annotations to design models that are referenced into sheets. You also 

may have added annotations directly on the sheet. If the annotations were too small, you would have 

changed the model's annotation scale, but that would have affected only the annotations directly on the 

sheet. The annotations in the reference were not changed. Therefore, the only way you could change 

the annotations was to exchange into the reference and scale them. 

Now the active model's annotation scale applies to annotations in references, too. If you change the 

scale of the annotations on the sheet, the scale of the annotations in the references changes as well. 

To make a reference's annotations use the active model's annotation scale, you must turn on this 

option. In the References dialog, there is a button along the bottom named Use Active Annotation Scale.  

Use this button to toggle this setting on and off as desired. 

 

Use Active Annotation Scale 
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2.5-3  Detail Scale 
Detail scale helps you represent the Master:Ref scale in terms of the sheet scale. For example, if your 

sheet scale (annotation scale) is 1/8” = 1´ and you want to place a detail reference of scale 1/4” = 1´, 

simply pick the new scale from the Detail Scale combo box. It automatically computes the Master:Ref 

scale as 2:1. 

2.5-4  Synchronize with Saved View 
When you attach a saved view, you can specify that the display of the reference should always be 

synchronized with the original saved view. In the Reference Attachment Settings dialog, turn on the 

Synchronize with Saved View check box. 

To change the appearance of a reference, you must modify the saved view that it is synchronized with. 

This is to ensure fidelity of display properties such as view attributes, level masks, clip volume, display 

styles and others. 

When synchronized, the reference location is also realigned. Specifically, when the reference is 

synchronized with the saved view, the reference center and saved view center remain aligned. You can 

see the effect of this in two ways:  

In an unsynchronized state, the reference is first shifted and then synchronized. 

When synchronized, the saved view center is changed; for example, the saved view is stretched. 

2.5-5  Change Attachment Orientation 
In this edition you can change the orientation of the reference attachment by clicking the reference's 

Orientation column in the References dialog.  

2.5-6  Reference Detail Scale 
When attaching a reference (a design or drawing model) into a sheet model, the referenced model's 

annotation scale is applied as the detail scale, and the Reference Scale (Master:Ref Scale) is calculated 

from the referenced model's annotation scale and the active model's annotation scale. 
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3. Imagery in MicroStation Platform – WMS and Map Insert 

3.1 Introduction to WMS 

A Web Map Service (WMS) is a standard protocol which provides georeferenced map images over the 

Internet that have been created by a map server using data from a GIS database.  At INDOT the map 

data is obtained from the ArcGIS Server.  The MicroStation platform can then be used to connect to the 

WMS.  The INDOT WMS server connections have already been established and preset WMS map 

definitions (XWMS files) have been created for the available images.  Currently the available map 

definitions are NAIP 2008, NAIP 2010, NAIP 2012, NAIP 2014, NAIP 2016, Ortho 2005, Quad 24k, 

2011_2013 Statewide Imagery, Best Available (which is a constantly updated map containing the most 

recent and highest resolution imagery, currently the 2011/2013 images), and Most Recent Available 

Imagery (which is the most recent imagery available but is not survey grade and will show differences in 

geocoordinated data situations).  These preset map definitions are in ProjectWise at the following 

location:  Documents\Resources\XWMS. 

3.1-1  Open Existing Map Definition 
NOTE: When importing any imagery files (including XWMS files, .iTIFF, .jpg, .pdf, etc.) into any 

MicroStation-based application, please note that you should only do so in 2D models.  DO NOT import 

them into 3D models—as this will cause significant issues if any plan sheets containing imagery files 

would need to be plotted. 

1. Open a MicroStation based session from within ProjectWise.  From the Drawing workflow, 

locate the Primary Group on the Home tab, click on the dropdown next to “Attach Tools”, and 

then select Raster Manager: 

 
 

Raster Manager 

  

pw://indot-pw.bentley.com:indot-pw-01/Documents/Resources/XWMS/
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2. On the Raster Manager window select File -> Attach -> WMS. 

 
 

Attach WMS 

3. ProjectWise’s Attach Raster Reference window appears.  In ProjectWise navigate to pw:\\indot-

pw.bentley.com:indot-pw-01\Documents\Resources\XWMS\.  Within this folder, select the 

XWMS resource file you need to attach. 

 
 

Attach Raster Reference Window 

pw://indot-pw.bentley.com:indot-pw-01/Documents/Resources/XWMS/
pw://indot-pw.bentley.com:indot-pw-01/Documents/Resources/XWMS/
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4. Once the XWMS file has been selected, select Add -> OK. 

 
 

Select an XWMS File 

5. In the Raster Attachment Options window adjust options as desired, and then select Attach at 

the bottom of the window. 

 

 
 

Raster Attachment Options 
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6. The image is now attached to the DGN as shown in the Raster Manager window. 

 
 

Attached Raster Image 

3.1-1a Attaching Aerial Imagery into Files with Direct 3D Reference Attachments 

A “defect” has been observed in ORD 2023 when aerial imagery is attached to a file that has an existing 

3D reference file (e.g., a survey fieldbook) directly attached.  In this example scenario, the aerial imagery 

is placed on top of the display of the referenced survey data in the file—which is undesirable behavior.  

Note how the imagery is placed on top of the survey data in the example below: 

 

Attached Aerial Imagery Concealing Survey Data 
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To get the survey data to display on top of the imagery as it should be, users will need to do the 

following: 

1. Open the References dialog. 

2. In the References dialog, go to Properties > Update Sequence. 

 

Update Sequence 

3. In the Update Sequence dialog, select your referenced 3D file (in this case the survey fieldbook) 

and using the arrow buttons at the top of the dialog, put that file at the bottom of the list.  Then 

click OK to proceed. 

  

Moving 3D Reference to Bottom of Update Sequence List 
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The survey data should then become displayed, as shown below: 

 

3D Survey Data Now Displayed 

3.1-2  Using Descartes to Merge Imagery 
When using the available WMS imagery, there may be a need to create a copy of the streamed imagery 

and have a direct image attachment to a file.  This section will cover the process to use the Descartes 

Merge tool to create this direct attachment and save it back to ProjectWise.  Doing so will ensure that 

the imagery used is always available as part of the project data. 

Also, this section will cover the settings to create a reasonably sized image with appropriate resolution 

and quality settings.  Note: Imagery settings are largely dependent on the situation where the imagery is 

being used.  These settings straddle a performance/size to quality line and should work for most 

situations.  Please keep in mind that large project areas or deviations from these settings can possibly 

result in very large image files that can negatively impact performance and downloads/uploads to the 

system. 
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To merge and create a directly attached image: 

1. With a DGN open and the WMS imagery attached, launch the Raster Manager.  On most 

workflows in OpenRoads this can be found on the Home ribbon under the Attach Tools shown 

below: 

 

Raster Manager 

2. With the Raster Manager open, select the active imagery that a file is going to be created from.   

3. Go to the Edit menu on the Raster Manager and select the Merge command: 

 

Merge Command 
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4. At this time the image extents will need defined.  This should accommodate the entire project 

extents unless it’s a large project, at which time consideration should be given to possibly 

creating multiple image attachments.  In this instance, a block will be used to create the image.  

Follow the prompts to draw a block around the project extents and when complete a dialog will 

display requesting the Merge Options. 

 

Defining Image Extents 
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5. On the Merge Options panel, settings for the extract image can be set.  Care should be given to 

the settings on this panel as deviation from the recommended settings can cause image sizes to 

quickly expand with little perceptible benefit.  The following image shows the recommended 

settings: 

a. Elements to Process: Rasters Only 

b. Create New Attachment(s): Enabled 

c. Resolution – Set Using: Pixel Size and DPI 

d. Pixel Size for both X and Y: 0.5 

e. DPI for both X and Y: 600 

f. Output – Single File, Internet TIFF64 

g. Output Options – Format Compression: JPEG Minimum Loss 

 

Merge Options Settings 

6. Once configured, select the Run command and the image will begin to process by prompting to 

create the new file in ProjectWise.  Create the image with the naming/settings desired.  Note 

that the default is to use the same name as the file the image is being created from. 
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7. At this time the processing begins and the session will appear to be inactive.  During this time, 

the merge command is downloading the appropriate resolution imagery from the WMS imagery 

and compiling the image requested.  This may take a few minutes to complete.  Upon 

conclusion, a new raster attachment will show in the Raster Manager.  If the display is disabled 

for the WMS imagery, the block of the new image should remain. 

 

Created Raster Attachment 

8. At this time, it’s highly recommended to switch back to ProjectWise and through either 

ProjectWise Explorer or the Local Document Organizer, Update the Server Copy for your itiff 

image so it is uploaded to the system.  Alternatively, it can be checked in when the file is closed. 

From this point onward, the created itiff image(s) can be used as the background image for the project 

and lessen reliance on the WMS imagery service.  Also, with the settings provided, the resulting image 

should be easily portable and perform well.  In the above example, the resulting image was 

approximately 30 MB for the entire area shown.   
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In addition to manually configuring the settings, CAD Support has created an Image Merge Presets.mrgx 

file that can be used to apply the above settings automatically.  This file can be found at pw:\\indot-

pw.bentley.com:indot-pw-01\Documents\Resources\XWMS\Merge Presets\.  This file can be used in 

one of two ways.  The first is attaching it during step 4 of the above.  To do so, change the Options on 

the Merge command from Open Dialog to Load Preset File as shown below. 

 

 

Loading Merge Presets File 

Proceeding this way will eliminate steps 5 and 6 and proceed straight to processing and placement in 

ProjectWise.   

Alternatively, if Step 4 proceeds with the Open Dialog, on the Merge Options dialog, there is a button to 

Load Preset File where the file can again be selected, and it will apply the settings discussed. 

  

Load Preset File 

  

pw://indot-pw.bentley.com:indot-pw-01/Documents/Resources/XWMS/Merge%20Presets/Image%20Merge%20Presets.mrgx
pw://indot-pw.bentley.com:indot-pw-01/Documents/Resources/XWMS/Merge%20Presets/
pw://indot-pw.bentley.com:indot-pw-01/Documents/Resources/XWMS/Merge%20Presets/
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3.1-3  Approximating Raster Transparency using Contrast and Brightness 
Applying transparency to aerial imagery in ORD has been quite problematic since INDOT has been using 

the application.  Several methods have been attempted to properly apply transparency to aerial 

imagery, but none of them have proven to be successful.  CAD Support has discovered an indirect way to 

apply transparency—and that is by adjusting the aerial imagery’s brightness and contrast settings.  The 

process for adjusting these settings on an itiff file in Raster Manager are explained below: 

Note: These following steps are only creating an approximation of raster transparency using the Contrast 

Brightness tools of raster manager.  In this method, the imagery will continue to be fully opaque and 

traditional transparency should be used if the situation necessitates it. 

1. With your .itiff file selected in Raster Manager, go to Utilities menu > Contrast Brightness. 

 
Contrast Brightness in Raster Manager 

2. On the Contrast/Brightness dialog that appears, adjust the settings as desired.  As a general 

guide, CAD Support has discovered that setting the Contrast to -20 and Brightness to 50 

roughly approximates a 50% transparency appearance when plotted. 

 
Contrast/Brightness Dialog 
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You can observe the difference in appearance on your sheets.  Again, you can adjust the settings as 

desired to suit your needs. 

 
Aerial Imagery without Contrast and Brightness Changes 

 
Aerial Imagery with Contrast and Brightness Changes 

 NOTE: In addition to using the Raster Manager to change the contrast and brightness settings for your 

aerial imagery, you can also make these changes via your plot settings in Print Organizer.  Please refer to 

our INDOTWise 5.1 Plotting document for details on how to make these changes. 
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3.2 Map Insert Application 

1. Locate the Map Insert link in the Explorer window of the MicroStation platform.  This can be 

found in the Links tab of the Explorer window, under INDOT > INDOT Info. 

 
Map Insert Link 

2. Click on the Map Insert link or copy the following URL to the web browser navigation (INDOT 

Map Insert (arcgis.com).  NOTE: The Map Insert Tool prefers Chrome, Edge, or Firefox. 

 

INDOT Map Insert Tool 

https://experience.arcgis.com/experience/bca834691cd643f09f98657a7e2538ab/page/Page/
https://experience.arcgis.com/experience/bca834691cd643f09f98657a7e2538ab/page/Page/
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3. At startup, the entire State of Indiana is displayed.  To zoom in to a specific area of the state you 

can use the mouse wheel.  By clicking the left mouse button and holding it down you can pan 

the view. 

4. Searching:  To zoom to a desired location, enter one of the following: county name, district 

name, project des#, or address. You may optionally select the type of search in the drop down. 

 

Performing a Search in INDOT Map Insert Tool 
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5. The Layers toolbox allows you to toggle on/off which layers are displayed in the view, and also 

provides you with a legend to denote the various layers.  Click on the Layers button in the top 

right corner of the page to access the toolbox.  Use the eye icons to toggle the layers on/off on 

the Layer tab and click on the Legend tab to see a legend of the various elements that are shown 

on the current view of the map.  NOTE: Some of the layers will be grayed out upon initially 

opening the Map Insert Tool.  This is because such layers are dependent on the zoom level you 

currently have on the map.  If you wish to toggle on/off such levels, zoom in on the map to your 

desired area such that those layers can now be seen. 

   

      Layer Tab    Legend Tab 

6. Once you have the area of interest displayed and the desired layers turned on, use the Print 

button to create the Map Insert image. 

 

Print Button in Map Insert Tool 
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7. On the Print template tab of the Print/Export window, enter a title for the map and select the 

applicable template.  You may need to test the sizes to find the desired output. Note: The 

MAP_ONLY template prints only the map, omitting any marginal information from the output. 

 

Print/Export Window 

8. For additonal printing options, click on the Advanced dropdown arrow. 

 

Advanced Dropdown Arrow 
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a. The following options are available: 

i. Map printing extents—Defines the method that the print service uses to 

calculate the printed extent of the map.  There are three options: Current map 

extent, Current map scale, and Set map scale.  Note that if you select the Set 

map scale option, you will be given a field to manually enter a desired scale. 

ii. Enter information in the optional Author and Copyright fields if necessary. 

iii. Check the Include legend check box if you wish to have a legend displayed on 

the printed map. 

iv. Check the Include north arrow check box if you wish to have a north arrow 

displayed on the printed map. 

v. Select the appropriate unit for the scale bar on the printed map from the 

Scalebar unit dropdown menu. 

vi. Print quality—Allows you to update the resolution of the printed map in units 

of DPI (dots per inch). 

vii. Check the Include attributes checkbox to include the feature's attributes in the 

feature collection layers. This is only applicable to custom print services that use 

the feature attributes, for example, to display a table of features and their 

attributes. 

viii. Check the Preview print extents checkbox to see a preview of the printed map 

extents upon clicking the Print button.  NOTE: This only applies when the 

Current map scale or Set map scale options are enabled for the Map printing 

extents setting.  If the Current map extent option is selected, the full extent of 

the map that is being displayed will automatically get printed. The extents are 

denoted by a black rectangular border with blue shading within it, as shown in 

an example below: 

 

Preview Print Extents  
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9. After all options have been set with the applicable values, click Print to submit all information to 

the print service.  You can then click on the Print result tab of the Print/Export to window to 

view the print operation as it’s being processed. 

 

Print Processing 

10. Upon successful processing, you can click on the created link to access the printed image. 

 

Successful Processing and Created Link 
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11. Clicking on the link will open a new tab in your web browser displaying the printed image. 

 

Printed Image 

12. Right-click on the printed image and save it to an applicable location on your computer. 

 

Saving the Printed Image 

13. With the printed image now saved to your computer, you can use the standard Windows drag-

and-drop procedure to upload it to your desired location in ProjectWise. 

14. Within the file you want to add the image to, attach the image as a raster.  
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3.3 Bing Maps Imagery 

Bentley has now directly integrated the use of Bing Maps into the base MicroStation platform and is 

extended to products built on it—such as OpenRoads Designer and OpenBridge Modeler. This 

functionality can be of beneficial use on appropriately geocoordinated files to verify survey data. 

Note: While this imagery can provide a quick check for geocoordination and other needs, it should be 

considered a secondary source as it may not fit accuracy needs and there may be inconsistencies with 

other agency provided imagery.  Finally, it may not be suitable due to the age of the imagery.  For those 

situations that require a higher level of accuracy, please continue to use the provided Web Map Service 

imagery discussed earlier in this chapter. 

Prior to the release of the 2023 MicroStation Platform, the Bing Maps functionality could be found 

under the view attributes for a given model and enabled there.  This has been moved in the 2023 

release and is now directly accessible from the View controls toolbar on each window: 

 
Bing Maps on View Controls 

It can also be found as part of the Geographic Toolbox: 

 
Geographic Toolbox 

Both options will provide several controls to allow Bing Maps to be displayed as background imagery in a 

geocoordinated file.  For the purposes of this discussion, the Geographic Toolbox version will be looked 

at, as it has some additional controls.   
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Assign Background Map 

The Geographic Toolbox version is a modal dialog, meaning that other tools cannot be accessed while 

this tool is open.  It has the following controls: 

1. Map Type 

a. None – Default, no background map 

b. Road – Basic road map display 

c. Aerial – Aerial imagery 

d. Hybrid – Combination Aerial imagery and roadway labeling (road names, route shields), 

along with some roadway overlays. 

2. Elevation Offset – 3D Only, allows specified elevation offset to prevent imagery from overlaying 

elements. 

3. Transparency – Controls transparency of imagery 

4. Target Views – Specifies the Views the selected imagery settings would be applied. 

A workflow using this tool would be as follows: 

1. Open a geocoordinated file, or apply appropriate geocoordination to an existing file where 

necessary. 

2. Select the Assign Background Map tool from the Geographic Toolbox. 

3. Select the Map Type desired. 

4. If 3D, specify the Elevation Offset. 

5. Specify the desired Transparency. 

6. Select the Target Views to apply these settings to. 

7. Select the Apply button to enable the selected imagery and settings to the selected views. 
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With these steps, the background imagery will then pull from Bing Maps.  Please note that unlike the 

WMS imagery, this background map is not considered an element and cannot be cropped, merged, or 

interacted with.  Also, it will not affect Fit View extents and these will still only use the extents of your 

active data when fitting the view. An example of the Hybrid option is shown below: 

 
Hybrid Bing Maps Option 

The steps to apply Bing Maps through the View Controls are similar—the only difference being that 

steps 6 and 7 are not necessary.  Using this method, it should be noted that Bing Maps imagery settings 

are only applied to the active view. 

  



 
101 

3.4 Geocoordinated Imagery with Sister Files 

There is an increasing need to reduce the file sizes of imagery, particularly the high resolution imagery 

that is produced by our agency survey teams.  In some situations, these groups are now producing high 

resolution imagery in the JPG format instead of TIFF files as these are substantially smaller.  Moving to 

the JPG file format however does have one disadvantage: in order to geocoordinate this imagery, a 

“Sister File” with the imagery geocoordination must be included alongside the file so it is reprojected 

properly and available in the MicroStation Platform application when the raster is viewed.   

The following steps will discuss how to properly associate these Sister Files (JGW format) to their JPGs 

and then attach and use them in the MS Platform. 

3.4-1  Using Reference Scanning to Associate the JPG and JGW Files 
To associate the JPG with its JGW file, the ProjectWise Reference Scan tool should be used, and is 

located under the Tools > Scan References and Link Sets menu entry or right click context menu on a 

folder.  The process is as follows: 

1. Ensure that you have both the JPG and JGW files in the same path and that files share the exact 

same name with the only difference being the file extensions.  It’s highly recommended that 

these be isolated in a folder of their own such as the Images folder when available.  This will 

prevent unnecessary file scanning and provide a better experience. 

 
JPG files and Identically Named JGW Files 

2. Launch the Scan References and Link sets tool from the menu or the right click menu on the 

folder. 
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Scan References and Link Sets 

3. The Scan References and Link Sets tool will be shown for the selected folder. 

4. Select Next on the first page of the wizard.  On the 2nd page, ensure that the Scan for master and 

referenced documents is selected.  The 2nd option for Scan for DGN Link Sets can be left enabled 

or disabled; it will have no bearing on the processing.  Select Next to proceed. 

 
Scan for Master and Referenced Documents 
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5. The next panel will request the path that the scan is being run on.  If launched from the right 

click context menu on the needed folder, this should already be populated.  If launched from the 

Tools menu, use the Folder dialog to locate the correct folder in the datasource.  Select Next 

when the folder(s) are selected. 

 
Select Master Files and Folders 

6. For the next step, we need to confirm the folder where the master files are, in this case the JPG 

files and the application formats to scan, confirm the prepopulated folder location shown from 

the previous step, and the applications being scanned.  In this case, the Images option is the 

only application that needs selected, however for convenience, all Applications can be selected 

with no impact to performance.  Note that this could have some performance impact if there are 

mixed file types in the folders with the imagery. 

 
Master Folder Settings 
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7. Next, we need to define our folder search options for the reference scan.  As the JPG and JGW 

files need to reside in the same folder, we can disable the Priority Search as we will not be 

searching additional folders.  Select Next to continue. 

 
Disable Priority Search 

8. By disabling Priority Search, Proximity Search will be enabled and not able to be changed.  This is 

the method that will be used for the reference scan, with the settings used as follows.  Again, 

the JPG and JGW should both reside in the same folder the scan is being performed on, so it’s 

unnecessary to Search Subfolders for References.  And for the Start Location, the Master File’s 

Folder will be the appropriate location.  This will limit the scan to only run on the folder we’ve 

previously defined.  Select Next to proceed. 

 
Proximity Search Options 

9. Next, we need to confirm the Search Order and if a log file is needed.  As the search is not using 

Priority settings and is Proximity Only, this value should be the default, and locked value.  A log 

file should not be necessary.  Select Next to continue. 
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Search Options and Logging 

10. The next panel is just confirming that the wizard has been completed.  Select Scan to proceed 

with the scanning process. 

 
Scan References Wizard Settings Complete 

11. The Scan Reference tool will now kick off and provide a status similar to the following 

illustration.  Note that depending on the size of the files involved, this can take some time to run 

as each image must be copied to the local machine for the process to complete.   
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Scan Reference Processing 

12. When complete, a section with detailed results will show the finished status of the process.  In 

this example, two JPG/JGW sets were completed. 

 
Scan Reference Results 

13. The final results can also be seen in the folder scanned as the JPG files now have a reference/set 

icon in the lower right of their document  
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JPG Files with Reference/Set Icon 

14. The reference/set can also be further verified by right clicking on the JPG file and selecting the 

Set > Show References entry. 

 
Set > Show References 

15. The window shown after selecting Show References will show that the JPG is now referencing 

the JGW and these two files will act as one when being accessed by the MS platform application. 
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JPG Referencing the JGW File 

3.4-2  Using Imagery with Sister Files in the MicroStation Platform 
This section will cover how to use imagery with Sister Files in the MicroStation Platform.  The majority of 

this process is the same as attaching any other imagery in the platform as explained in steps 1-4 from 

3.1-1 Open Existing Map Definition, with the only differences being to replace WMS with Raster in step 

two, and XWMS with JPG in all steps.  This process will pick up with the changes that would differ 

starting in step 5. 

When attaching a JPG with JGW Sister File, the primary difference between this and a standard image 

attachment is on the Raster Attachment Options.  When presented with the attachment dialog, under 

the Geometry heading there will be an entry for Geo Priority and this will default to the value 

Attachment.  This instructs the platform application to use any geocoordination information from the 

file to be used.  As JPG files do not have this imagery in their file content directly, the Geo Priority setting 

should be changed to Sister File.  This will instruct the application to use the geocoordination to be 

based on the associated JGW file and will not be able to be selected unless the JGW file is available. 
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Raster Attachment > Geo Priority 

If the Geo Priority does not allow for the Sister File entry to be selected as shown in the previous 

illustration, ensure that the Reference Scan covers in the previous section has been completed and that 

the JPG and JGW are in the same folder and associated properly. 

4. Geospatial Context Workflow 
Released as part of the MicroStation 2023 platform, the Geospatial Context workflow allows users to 

attach geospatial data to their files.  The inclusion of this toolset allows for information of the following 

types to be easily attached—and in some cases—directly imported into CAD files.  Some of the 

geospatial sources that can be attached to files include the following: 

• Integrated Bing Map Imagery 

• Web Feature Services (ESRI and OGC) 

• Web Map Services (ESRI and OGC) 

Note: INDOT CAD Support will not be able to assist in locating specific GIS datasources, and any 

questions on what data may be available should be directed to the INDOT IT – GIS Support group. 

Also, while technically not part of the Geospatial Context workflow per se, users are able to import 

terrain data from GIS datasources.  Additional information on this functionality can be found in Section 

1.8 of the current INDOTWise 5.1 ORD Plans Production document. 
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4.1 The Geospatial Context Ribbon 

The Geospatial Context ribbon can be accessed by loading the Geospatial Context workflow from the 

MicroStation/OpenRoads Designer interface: 

 
Geospatial Context Workflow 
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The Geospatial Context ribbon will then be displayed in the interface. 

 

Geospatial Context Workflow 

This ribbon contains the following tools (from L to R): 

• Geographic – Coordinate System – This tool is used to attach/modify coordinate systems to the 

DGN file 

• Geographic – Bing Maps – Attaches Bing Maps; this is the same functionality as covered in the 

previous section. 

• Feature Services – New – Creates a connection to a Web Feature Service. 

• Feature Services – Delete – Deletes a Web Feature Service connection. 

• Feature Services – Edit – Configures the layers available in the Web Feature Service. 

• Feature Services – Query Features – Creates CAD elements of selected GIS Layers and selection 

area. 

• Feature Services – Clear Features – Removes CAD elements queried from the Web Feature 

Service. 

• Raster Services – New ArcGIS – Creates a connection to an ArcGIS REST Map and Imagery 

Service. 

• Raster Services – Attach ArcGIS – Allows for the connection of pre-defined ArcGIS connections. 

• Raster Services – New WMS – Creates a connection to Web Map Services imagery. 

• Raster Services – Attach WMS – Allows for the connection of a pre-defined Web Map Service 

connection.  This is the same functionality as covered in section 3.1 of this document. 

• Raster Services – New WMTS – Creates a connection to Web Map Tile Services imagery. 

• Raster Services – Attach WMTS – Allows for the connection of a pre-defined Web Map Tile 

Service connection. 

For the majority of the readily accessible GIS sources available to INDOT, the Web Feature and Web Map 

Services will be the tools that are primarily used.  For discussion on the latter, please see section 3.1 of 

this document. 

  



 
112 

4.2 Attaching and Querying Web Feature Services 

The tools under the Feature Services section of the Geospatial Context ribbon allow for the direct import 

of GIS data to CAD elements.  This can include linear, polygon, and point features.  Along with creating 

CAD elements, this will also append any GIS metadata to the created element that can be investigated 

along with the elements themselves.  The following will cover how to connect, import, resymbolize, and 

view the properties of GIS elements. 

Some important notes on the Web Feature Services connectivity: 

• Please keep in mind that the symbology of the imported CAD elements are driven by their 

definition in the GIS datasource and symbology overrides on import cannot be defined through 

these tools.  Users will need to adjust symbology post-import if the symbology from GIS is 

insufficient for their needs. 

• Web Feature Service Connectivity is maintained on a per-file basis.  Any connections established 

will be re-established when the file is opened by any user. 

• In 3D files/models, all imported content will have a 0 elevation.  It’s recommended to perform 

imports into 2D files specifically created to hold this information.  If adjustments are needed for 

clarity, reference priority can then be used to adjust the level of the imported information. 

• Bringing web feature service content into a file can result in enlarged file sizes.  This will be 

dependent on the quantity of elements and their complexity.  Please keep this in mind when 

determining how best to bring this data in, and whether it would be beneficial to keep separate 

imports in their own files. 

4.2-1  New Web Feature Service Connection 
The first step to connecting to a Web Feature Service is through the Feature Services – New tool on the 

ribbon. 

 
New Web Feature Service Connection 
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This will display the New Feature Service Connection dialog as shown below: 

 
New Feature Service Connection 

The following fields are available: 

• Server URL – Web address of the Web Feature Service; this field will remember a list of recently 

used connection addresses. 

• Connection Name – Name of the connection; can be pre-defined by the Web Feature Service or 

set by the end user.  This will also be used as a prefix for the level name for the imported 

features. 

• User Name – If necessary, the user name for the Web Feature Service. 

• Password – If necessary, the password for the Web Feature Service. 

Many feature services are freely available, and will not require a User Name/Password.  In these 

instances, do not enter account information.  Others may require accounts to be configured, so please 

reach out to the service provider for their access requirements. 

In this example, both a linear/polygon and point feature datasets will be looked at and are provided for 

illustration purposes only.  The services being used are: 

• Parcel_Boundaries_of_Indiana_2023 – Hosted/Parcel_Boundaries_of_Indiana_2023 

(FeatureServer) Linear/Polygon Features 

• LRSE_Bridge_Point – Hosted/LRSE_Bridge_Point (FeatureServer) Point Features 

  

https://gisdata.in.gov/server/rest/services/Hosted/Parcel_Boundaries_of_Indiana_2023/FeatureServer
https://gisdata.in.gov/server/rest/services/Hosted/Parcel_Boundaries_of_Indiana_2023/FeatureServer
https://gisdata.in.gov/server/rest/services/Hosted/LRSE_Bridge_Point/FeatureServer
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Going to the link for the Parcel Boundaries, copy the address from the URL and paste it into the Server 

URL field.  Press the Tab key on your keyboard to confirm the connection and populate the Connection 

Name field, or alternatively you can enter an appropriate and recognizable name.  For this feature 

service, no username or password is required. 

 
Feature Service URL 

 

 
Feature Service Connection 
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When ready, select OK and the connection will be established and a prompt displaying all available 

layers for query will be displayed.  This connection only has one layer for the parcel boundaries 

themselves.  By default, all layers available will be selected.  Select the requested layers if more than 

one is available and click Connect. 

 

 
Layer Selection 

Next, the other GIS source for bridge locations will be attached.  The previous steps should be repeated 

to attach the feature service.   
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4.2-2  Editing the Web Feature Services 
With both feature services connected, select the Edit button on the ribbon to validate the connectivity 

of the feature services.   

 
Edit Feature Services 

Again, if a particular service contains more than one layer, these will be displayed based on if they have 

been selected or not. 

 
Active Feature Connections 

When satisfied with the layers/connection selected, select OK to proceed. 
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4.2-3  Querying the Feature Service 
With the feature services connected and the layers selected, these can now be queried and have CAD 

graphics created from their data.  

 
Query Features 

Please note that the tool tip specifies that the Active View Extent is specified.  When run, any features 

that are within the active view extents AND those that even cross the active view extents will be 

attached to the file.  The following screen capture illustrates a sample alignment and the green, dashed 

shape illustrates the view extents prior to the query. 

 
View Extents Illustration 
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Selecting the Query Features button will kick off the import from the feature service and its 

progress/status will be shown in the MicroStation/OpenRoads Designer message center. 

 
Query Feature Complete Status 

With the query complete, the elements have been created.  Based on the symbology definition received 

from GIS for this particular layer, it appears that nothing has been created.  To see if elements have 

been created, hover over the view with the selection cursor and the features will show with a shadowed 

selection. 

 
Created Elements 

This will illustrate that the graphics have been created, and the following sections will cover how to 

resymbolize these graphics to make them visible for use if the GIS symbology definition does not 

translate cleanly. 
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4.2-3a Linear/Polygon Features Symbology 

As previously discussed, the GIS feature service controls the symbology that is provided to 

MicroStation/OpenRoads Designer, and as part of the application of this symbology, each element has 

its own discreet symbology.  These imported graphics unfortunately do not utilize a Bylevel symbology 

definition.   

This section will cover an example CAD process to select these elements, set their symbology to a 

Bylevel definition, and then adjust the symbology to something suitable for use.  To start, select the 

Element Selection tool, and ensure that the Extended Settings are enabled, select the Level selector 

panel.  On this panel, select the level name for the imported graphics.  The convention for this level 

naming is [connection name]-[layer name] and in this case resolves to 

Hosted_Parcel_Boundaries_of_Indiana_2023-Parcel Boundaries of Indiana 2023. 

 
Selection of Created Level 
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Then load the Element Information panel if not already loaded.  This will show all elements available on 

the selected level, and from here the symbology can be adjusted to Bylevel.  Select the Color, Line Style,  

and Weight; and select  Bylevel for their respective value. 

 
Element Information and Setting Bylevel Symbology 

One thing to keep in mind is that this particular symbology does have per element Transparency also 

applied.  In this specific scenario, it has been set to 100% transparency, preventing the elements from 

displaying at all.  To address this, set the Transparency to 50% to get an initial gauge of element display. 

  



 
121 

With the transparency, set, it should also be apparent that element fill is enabled for these features, and 

in this case, it might be advantageous to set this display to no fill which will preserve the edges of the 

polygon and not interfere with the display of other graphical elements. 

 
Disabling Fill 
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With these settings adjusted, the display would appear like the following.  Note that the green line 

illustrating the original view extents crosses the features that have been imported, showing how the 

Query command defines its extents. 

 
Imported Feature Initial Cleanup 

With the symbology cleaned up and using Bylevel symbology, their display can be then adjusted through 

the Level Manager to the desired color/linestyle/weight.  For this example, the settings have been 

adjusted as shown, with the resulting final appearance. Note that this is an exaggerated symbology for 

illustration purposes. 

 
Level Manager Symbology 
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Resulting Symbology 

4.2-3b Point Feature Symbology 

When importing point features, these too receive discreet, per element symbology settings.  However, 

their nature as point features provide additional complications for visibility that can be addressed 

through the following steps. 

Continuing from our previous example, our sample project has a small structure located along it that is 

located using the LRSE Bridge Point feature service.  To enhance clarity, all other data except the view 

extents have been disabled.  After performing the query, a point has been placed in the extents 

representing the small structure.  This point has been selected to increase its visibility as well.  The 

symbology as initially defined will only display as a small white dot. 
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Point Feature Location 

To increase the visibility, the same process can be used as with the linear features weight to Bylevel, and 

adjust any transparency as needed.  Color cannot be adjusted and linestyle is unnecessary to adjust.  In 

this instance, setting the weight of the level to 10, provides good visibility.  Note that the weight is a 

dynamic setting on the point, so the symbology will remain the same size regardless of zoom level.  Also, 

through this method, it should be noted that there was another small structure that was at the very 

edge of our view extents that wasn’t otherwise visible. 

 
Point Feature Level Weight 
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Resulting Symbology 

Additional Notes on Point Symbology: 

• Depending on the point feature imported, a shared cell model may be imported into the DGN at 

the time the query is run.  In this instance, a new model called esriSMSCircle has been created 

consistent with the shared cell in use. 

  
• Depending on the shared cell that is brought in, the scale may be adjusted to increase visibility, 

which will be dependent on the settings provided by the GIS feature service. 
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4.2-4  Deleting Web Feature Service Connections 
To delete a Web Feature Service Connection, select the Delete button on the ribbon. 

  
Delete a Web Feature Service Connection 

This will present the list of active feature service connections available in the open file.  Simply select the 

check mark next to the connection that is to be removed and select Delete.  This will prevent the 

connection from being queried on subsequent operations but will not remove any graphics that were 

created by it. 

 
Delete Feature Service Connection 

  



 
127 

4.2-5  Clear Features 
The Clear Features tool is used to remove all items that have been displayed by the Query Features tool.   

 
Clear Features 

Usage of this tool will remove these graphical features if the connection is still active.  If a connection 

has been deleted, the graphics will not be removed. 

Note: Any graphic features that are removed using this tool will not retain any Bylevel symbology 

settings that were previously defined.  The resymbolization process will have to be performed again on 

the new elements. 

4.2-6  Reviewing Web Feature Data 
One of the many advantages to bringing in Web Feature Service data is that not only are spatial 

locations and boundaries provided, but each feature carries its accompanying metadata from the GIS 

feature service.  This section will cover what can be expected of these features. 

Continuing from the previous sections, the resulting data with both our linear/polygon and point data is 

as shown combined with aerial imagery and the project survey. 

 
Combined CAD/GIS Data 
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At this point, simply selecting on any of the import elements will expose the metadata that was brought 

over with the feature from GIS.  The following illustrates one of the parcels that was imported along 

with one of the bridge points.  Note that the Metadata information shows up in the Element 

Information panel under a heading named after the layer it was imported by, and that all the fields 

under the heading are provided by the GIS system.  As with the symbology, the GIS Feature Service 

provides this information, and it cannot be modified as part of the import process. 

 
GIS Metadata on a Linear/Polygon Feature 
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GIS Metadata on a Point Feature 

The metadata fields that are appended to the elements are part of what is called Item Type functionality 

in the MicroStation platform.  By appending this information in this manner, users can report and 

annotate directly off these fields.  If there is a specific need, please contact CAD Support to discuss and 

determine the best way forward with any potential needs. 
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4.3 Using the GIS Template Seed File 

Thanks to the efforts of our internal Design staff, we have implemented a GIS template seed file 

(General GIS Template.dgn) that contains several preconfigured connections to various GIS feature 

services.  This seed file can be found under the Template Documents\ORD-Connect Seed\GIS Seed 

Templates folder in ProjectWise. 

 

Location of General GIS Template File in ProjectWise 

Upon opening the seed file, you will notice that it is preconfigured to display the Road background map 

from Bing Maps by default.  If you wish to change the background map, you can do so via the Bing Maps 

tool in the view window. 

 

Bing Maps Tool in View Toolbar 

To view all of the preconfigured GIS feature service connections, simply click on the Edit button on the 

Home tab of the workflow. 

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/GIS%20Seed%20Templates/General%20GIS%20Template.dgn
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Preconfigured GIS Feature Service Connections in GIS Template Seed File 

Then at this point, it is simply a matter of working with the geospatial data via the processes highlighted 

earlier in this chapter. 



 
132 

5.  MicroStation Platform - Plans Production 
This chapter will first cover the standard INDOT naming convention for various types of MicroStation-

based drawings.  Then what follows is a description of the processes involved with sheets that are 

manually created from our DGN template document files.  Examples will be given for the creation of title 

and index sheets, and then there will be separate discussions of the specific plans production process for 

Resurface and Traffic plans.  For recommendations on sheet naming, please see section 4.4 which covers 

a variety of potential sheets that may be included in a project or found in legacy data. 

5.1 Creating Sheets from DGN Template Documents 

The first step in creating sheets from our DGN template documents is to first make a copy of our 

INDOT_US_SVFT_2Dseed.dgn file into your project.  This serves as a template file that you can work 

from.  Then within that file, you can import in the necessary sheet model from one of our template 

documents—namely D size_sheets.dgn and Ltr_sheets.dgn—depending on the plan sheet size that 

you’re working with.  These files can be found within the DGN folder under Template Documents in 

ProjectWise.  What follows are the next steps in the process for creating a title sheet and for creating an 

index sheet.  For the following examples, full size sheets for road plans will be used. 

5.1-1  Creating a Title Sheet 
With the seed file copied into your project and named according to standard title sheet convention, 

perform the following steps: 

1. With the title sheet file open, open the Models dialog and click on the Import Models button. 

 
Import Models Button in Models Dialog 

  

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/INDOT_US_SVFT_2Dseed.dgn
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/DGN/D%20size_sheets.dgn
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/DGN/Ltr_sheets.dgn
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/DGN/
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/
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2. On the Import Model From File dialog that opens, navigate to the location of the D 

size_sheets.dgn file in ProjectWise and click Open. 

 
Selecting D size_sheets.dgn File 

3. A Select Models dialog will then appear with a list of all the sheet models that reside within the 

D size_sheets.dgn file.  Select the appropriate title sheet model in this list and click OK.  For this 

example, we will select the RD_Title Sheet model. 

 
Selecting Title Sheet Model from D size_sheets.dgn File 

4. A new title sheet model will now be placed into your file. 
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Title Sheet Model 
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There are a couple areas of the title sheet to note.  At the bottom right-hand corner, you will see the 

project Des Number, Contract Number, and Project Number fields already populated.  These fields 

automatically populate based on the properties of the project (“Work Area” in ProjectWise terms).  A 

look at the document properties of the title sheet will show this information. 

 

 
Automatically Populated Information on Title Sheet 
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Then at the top right corner are the Traffic Data and Design Data tables.   This information gets 

populated from the Attributes tab of the document properties.  Note that if you have the title sheet 

open when you enter this information on the Attributes tab and save it, you will need to close and 

reopen the title sheet for the changes to take effect. 

 

Populated Design Data Information from Attributes Tab 
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5.1-2  Creating an Index Sheet 
To create an index sheet, you will perform the same initial steps as you do for the title sheet, where you 

create an index sheet file from a seed, and then proceed with the model import from D size_sheets.dgn.  

The only difference is that at the Select Models dialog, you will select the RD_Index Sheet model. 

 
Selecting RD_Index Sheet Model 

 A new index sheet model will now be placed into your file. 

 

Index Sheet Model 

There are a couple areas of the index sheet to note.  First is the Index table in the top right.  A few rows 

are in the table initially.  To add rows to the table, simply copy and paste the bottom row, as necessary. 
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Copying Bottom Row of Index Table 

Then for the General Notes table in the top middle section of the sheet, you can navigate to the INDOT 

Tools workflow, click on the Cells tab, and select the Tables-Legend-Notes Cells cell library to find the 

general notes that can be placed in this table. 

 
Adding General Notes 
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5.2 Resurface Plans 

The following sections discuss MicroStation platform and Microsoft Excel resources to be used in the 

development of a set of resurface plans. 

Resurface plans can be composed of one .dgn file with multiple sheet models, or several .dgn files each 

having a single sheet model.  Regardless of the method that is used to create these plans, they should be 

produced using the 8.5” x 11” borders available in the Ltr_sheets.dgn template file. 

 
Ltr_sheets.dgn Location 

This file contains a title sheet model, and a set of four sheet models that can and should be used to 

develop each of the sheets in a set of Resurface Plans.  These sheet models are: 

- Ltr. Title Sheet. This sheet model is the standard title sheet to be used with 8.5” x 11” plans. 

- Ltr. Detail.  This sheet model is a standard, empty 8.5” x 11” border sheet oriented in portrait.   

- Ltr. Landscape Detail.  This sheet model is a standard, empty 8.5” x 11” border sheet oriented in 

landscape.   

- Ltr. Detour Sheet Signing. This sheet model is available to be used for the Recommended Detour 

Signing sheet. 

- Ltr. Index.  This sheet model is for index sheet content. 

For the detail and index sheets, there is also a corresponding sheet model for the placement of an 

engineer stamp. 

These plan sheets should follow all drafting standards as specified the INDOT CAD Standards Manual, 

available for download from the INDOT CAD Support web page.  See the Indiana Design Manual for 

information regarding the sheet content. 

  

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/DGN/Ltr_sheets.dgn
http://www.in.gov/indot/design_manual/files/INDOT_CAD_Standards.pdf
https://www.in.gov/indot/doing-business-with-indot/other-business/cad-support/
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5.2-1  Ltr. Title Sheet 
This sheet model should be used as the title sheet for all plans created using the 8.5” x 11” format.  This 

and all other sheet models in Ltr_sheets.dgn take advantage of attribute exchange information which 

allows population of fields using the Universal Title sheet. 

While in the open file, import the sheet model titled Ltr. Title Sheet model from Ltr_Sheets.dgn.    When 

you open the newly imported sheet model, it will appear as shown in the illustration below. 

 
Ltr. Title Sheet Model 

5.2-1a Placing the Location Map 

Please refer to section 3.2—which covers the use of the INDOT Map Insert Application. 
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5.2-1b Placement of County Cells and Project Location Symbol 

Placement of the county cell and project location symbol are accomplished by using the INDOT Tools 

workflow. 

1. With the INDOT Tools workflow open, select the County District Maps tool in the Cells tab. 

 
County District Maps Tool 

2. Within the Cell Library, navigate to and double left mouse click on the appropriate county or 

counties. 

 
Selecting a County 

3. For 8.5” x 11” plans, you will need to set the X and Y scales to 0.50 

 
Setting the X and Y Scales 

4. Place the active cell by using the lower left corner of the Project Location box as your hook 

point. 
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Placing the Cell 

To place the location symbol, use MicroStation based commands to copy the symbol from within the 

Project Location box to its correct positioning. 

 
Project Location Box 
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5.2-1c Universal Title Sheet  

The Universal Title Sheet is used to populate portions of the 8.5” x 11” Title sheet.  This information 

should only be edited using the Universal Title Sheet to ensure that that information is populated 

throughout the entire set of plans.  For further information on the ProjectWise attributes panel and how 

to interact with it, please see the DOTWise 5.0 ProjectWise module. 

The Universal Title Sheet is accessed within ProjectWise by selecting the Attributes Tab of the Properties 

dialog box of the design file (.dgn) and ensuring that the Interface is set to _PROJECT INFORMATION 

 
Universal Title Sheet 

See Chapter 2 for more information regarding use of the Universal Title Sheet. 
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5.2-2  Ltr. Detail and Ltr. Landscape Detail 
These sheet models are standard, empty 8.5” x 11” border sheets oriented in portrait and landscape.  

This border sheet can be used for any drawing detail or table in a set of resurface plans.  

While in the open file, import the sheet model titled Ltr. Detail Model from Ltr_Sheets.dgn.    When you 

open the newly imported sheet model, it will appear as shown below.   Text outside of the border is 

populated with the Universal Title Sheet.  The title of the sheet is edited by changing the description of 

the sheet model within the Model Properties dialog box.  Draw or reference details into the area within 

the border. 

      

Ltr Detail Sheets w/PE Stamp 

5.2-2a Editing the Sheet Title 

1. Within the file (you do not need to be in the target sheet model) open the Properties dialog for 

the target sheet model by clicking on the Edit Model Properties button. 

 
Edit Model Properties Button 
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2. In the Properties dialog that appears, edit the description of the sheet model to reflect the title 

of the drawing Detail. 

 
Edit Description 

3. The title change will be reflected in your sheet model. 

 
Changed Sheet Title 
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5.2-3  Ltr. Detour Sheet Signing 
This sheet model was set up to be used for the Recommended Detour Signing sheet.  This sheet model is 

pre-populated with a standard signing legend and uses the Universal Title Sheet to populate the route 

into the title of the sheet. 

While in the open file, import the sheet model titled Ltr. Detour Sheet Signing from Ltr_Sheets.dgn.    

When you open the newly imported sheet model, it will appear as shown below. 

 
Detour Signing Sheet 

5.2-4  Miscellaneous Tables and Strip Maps 
During the process of creating a set of plans on the 8.5” x 11” border sheets, you will need to add 

various summary tables and or strip map.   

5.2-4a Miscellaneous Tables 

INDOT has provided a template Microsoft Excel file that contains several different tables that are 

commonly used (and some not so commonly used) on resurface plans.  These Excel tables have been 

formatted to be cut/pasted into the provided sheet models at a 1:1 scale. 

The Microsoft Excel Tables are available in ProjectWise at: 

pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template Documents\Seed\Spreadsheets\ 

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/Seed/Spreadsheets/
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Instructions for each table are included on each sheet within the Microsoft Excel file.  Once completed, 

the tables can then be copied and pasted into a MicroStation sheet model. 

Copy and Paste Tables into Sheet Model. 

1. Complete the Excel spreadsheet and select the area that you wish to copy into a sheet model.  

Then either Right Click → Copy with your mouse or enter Ctrl + C on your keyboard to copy that 

information. 

 
Copy Table Contents from Excel 

2. In the target sheet model, select the Paste tool from the Home tab of the Drawing workflow:  

 

Paste Excel Data into the MicroStation Platform from Excel 
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3. Select the area in which you want to paste the table in the sheet model using tentative snaps.  

This will paste a picture of the table in the sheet model.  This image is not editable.  To edit the 

table, you will need to edit the spreadsheet file and then repeat the copy – paste operation. 

 
Copied Excel Table 

Due to ProjectWise functionality, it is highly recommended that users do not embed or link Excel sheets.  

There are two major issues that make these processes undesirable: 

• Embedding – With an embedded spreadsheet, the CAD file must be open and then the Excel 

content opened from within the DGN.  Additionally, one cannot link data across sheets with 

embedded Excel content. 

• Linking – Due to the way ProjectWise functions with unique working directories for all users, 

linking will not work for any users other than the link creator. 

  



 
149 

5.2-4b Strip Maps 

Additionally, as part of a set of Resurface Plans, per the Indiana Design Manual, a Strip Map is required.  

This should also be created using the Ltr. Detail or Ltr. Landscape Detail sheet model(s). 

Examples of a typical Strip Map are shown here. 

 

Strip Map Examples 

  

http://www.in.gov/indot/design_manual/files/INDOT_CAD_Standards.pdf
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5.3 Traffic Plans Production 

For the following section, users should be reminded that Traffic/Signals has their own customized ribbon 

that contains all functionality from the SS10 workspace under the INDOT Tools > Traffic location.  This is 

briefly discussed in section 2.1-1b INDOT Tools Workflow. 

 
INDOT Tools Workflow > Traffic Ribbon 

The tools on this ribbon are as follows: 

• Lighting Library – Lighting cell  

• Signals Library – Signals cells 

• Pavement Markings Library – Pavement Marking cells 

• Symbols Library – Symbol cells 

• Tables-Legends-Notes_Traffic – Traffic Specific Legends and other notational cells. 

• Launch AutoTurn – Launch the AutoTurn application add in. 

These tools have been listed specifically for Signs Signals and Lighting use and to allow for a single, more 

convenient location to access them.  Note: The Tables-Legend-Notes_Traffic tool points to a cell library 

that’s only available in this ribbon and differs from the version available on the INDOT Tools > Cells 

ribbon.  The traffic version contains those entries specific to the Signs Signals and Lighting process. 

5.3-1  Signs Signals and Lighting Plans 
The following sections discuss MicroStation Platform resources to be used in the development of a set 

of Traffic plans for Signs Signals or Lighting. 

Traffic plans will normally start from the INDOT_US_SVFT_2Dseed.dgn seed file located in ProjectWise.  

For more recent surveys, a geocoordinated version of one of these files will be found in the Survey 

Project Files folder.   

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/INDOT_US_SVFT_2Dseed.dgn
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Example Geocoordinated Seed Location 

The previous screen capture shows an illustration of where you might find the geocoordinated seed files 

if your project has been setup.  This should be the first location where seed files should be located.  If 

there is no survey data and the project has not been geocoordinated, the files will need to be selected 

from the Template Documents location shown below.  Regardless of which file is being created, it is 

highly recommended to use the Advanced Document Creation Wizard. 

Additional seed files can be found at pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template 

Documents\ORD-Connect Seed\ in the event an appropriate seed has not been provided. 

Note: For information on creating documents from the appropriate seed files in the DOTWise system, 

please see the INDOTWise 5.0 DOTWise ProjectWise module with discussion on the procedure, and 

section 1.1 CAD Seed/Template Files for specific information on the files that should be used. 

  

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/
pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/ORD-Connect%20Seed/
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5.3-2  Traffic Plans Creation 
With a template document now created, the Traffic Plans can start being assembled.  The first portion of 

the Traffic Plan composition is the creation of the project title sheet.  The first method of creation will be 

from pre-existing plan images. 

5.3-2a Creating the Design from As-Built Plan Image 

To start this process, first go back to the DGN that was created earlier in this section, Des#_Traffic Signal 

Plans.dgn.  Open the file from ProjectWise and switch to a new model.  For more details on 

creating/editing models, please refer to Appendix C of this document, or the application help file. 

In a new model, start by opening the Raster Manager.  This can be found in the Attach Tools dropdown 

under the Home tab of the Drawing workflow. 

 
Start Raster Manager 

After initiating the Raster Manager, the Raster Manager dialog will be displayed.  On this dialog, select 

the Attach > Raster… command from the File menu: 

 
Attaching a Raster 
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Next, locate the scanned/PDF copy of the As Built Plans for the project.  As with most other project 

deliverables, these should be uploaded to ProjectWise for easy location, management, and security.   

 
Locating the As Built Reference 

During the attachment process, make sure that the Raster is attached at a 1:1 scale.  It is very important 

that the raster be attached this way to determine the necessary scale factor to rescale the raster by. 

At this time, scaling of the As Built needs determined to draft the elements true scale.  To determine the 

scale, locate some of the dimensioned elements on the raster and measure them using the application 

measurement tools. 

 
Measurement Tools 
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To determine the scale factor needed to upscale the raster by, take the as dimensioned measurement 

from the drawing and divide it by the measured value using the tools.  For example, the following 

illustration shows a dimensioned line that is listed at 19.5’.  The MicroStation tools measured this to be 

displayed as 0.0752’.  To calculate the scale factor, divide the dimensioned by the measured 

(19.5’/0.0752’) resulting in a scale factor of 259.31. 

 
Raster Scaling 

With the raster now scaled properly, one can now start drafting based on the As Built raster.  Using the 

standard MicroStation drawing and Level tools, trace the geometry on the appropriate levels as 

provided in the DGNLib.  These levels include the _TRAF_ prefix and can be filtered using the DGNLib 

filters as shown. 

 
Traffic Proposed and Existing Filters 
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Setting the Active Level, Color, and Linestyle 

Once completed tracing the As Built information, the Raster Image can be detached.  Do so by opening 

the Raster Manager, and highlighting the As Built, and either Right Click -> Detach, or from the File -> 

Detach menu option shown below.  

 
Detaching a Raster 

At this point, the Traffic Plans should be completed using standard MicroStation tools.  Later in this 

chapter, a review of sheet creation will occur.  First however, brief explanations of alternate plan 

creation methods will be discussed. 

5.3-2b Creating Traffic Plans Without As Builts 

In many projects, it is quite common to start a project without any As Built data.  In this instance, 

alternate sources of data can be used to have a raster image background from which the geometry can 

be traced.   

As with the previous section, start by creating a new model.  Once prepared, start the Raster Manager 

as discussed in the previous section.  

In this instance, an As Built will not be available.  In lieu of this, the INDOT GIS department has made 

available a listing of WMS Web Map Services.  These map services were discussed previously in section 

3.1 Introduction to WMS, however a brief overview of the attachment process is provided here. 
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The first step is to select the File -> Attach -> WMS: 

 
 

Attaching a WMS Map 

On the presented Attach Raster Reference dialog, navigate to the XWMS folder in ProjectWise.  This 

folder is located at:  

pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Resources\XWMS\ 

Select the CADStreetAnno.xwms, and the Current Indiana Statewide Imagery.xwms and select OK.  

Please note that the GIS staff is constantly acquiring and processing new imagery, so newer versions of 

these maps may be available, especially the Full Res images.  Check often if new images have been made 

available. 

Note:  When using the rasters, the following issues may be encountered: 

1. Each set of rasters has benefits and disadvantages, use the Orthos that fit your project needs for 

the best experience. 

2. The plotting of raster images within 3D models presents some known issues.  If you know you 

will be plotting such images for use on plan sheets, only use a 2D seed file when creating your 

base sheets. 

 
WMS Raster Attachment 

pw://indot-pw.bentley.com:indot-pw-01/Documents/Resources/XWMS/
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With the images now attached, MicroStation will start streaming the images based on where your view 

is located.  It is highly recommended to zoom all the way out, so the entire state map is visible, and then 

Zoom down to the intersection. 

With the location of the intersection found, go back to the Raster Manager.  Highlight the 

CADStreetAnno.xwms, and then select Display -> Bring to Front from the Raster Manager toolbar. 

 
Bringing the CADStreetAnno.xwms to the Front 

At this time, the extraneous raster imagery needs cropped out.  Select the Clip tool from the Raster 

Manager toolbar and then crop the rasters to just the needed area. 

 
Raster Clipping 
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Clipped Raster 

Next, the rasters need to have their geolocation enabled so they display in the correct spot on the DGN.  

To do so, view the Properties of the rasters, and set the “Inherit GeoCS from Model” setting under 

Geometry > Geocoding to Not Inherited (as shown below), so that image falls into place. 

 
Setting the GeoCS to Not Inherited 

At this point, the plan development process is the same as in the previous example.  Trace the geometry 

using the appropriate symbology and detach the rasters when completed. 
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5.3-2c Traffic Plans when Survey or Design Data is Available 

In this instance, the traffic plans process will start from pre-existing data directly in a MicroStation 

format.  As was discussed earlier in this chapter, the first place to look for a seed file in this instance will 

be under the Survey\Project Files folder for the project. 

At this time, the Survey Geometry can be used directly from the TOPO drawings.  Note that there are a 

variety of methods to get and use this data: 

• The data can be referenced and traced. 

• The data can be referenced and merged. 

• The data can be referenced and copied directly. 

Depending on the method chosen, the data must be modified to the appropriate symbology for Traffic 

Plans and the development process can occur. 

The above processes are also valid when working on Traffic Plans that are part of a broader Design 

project.  In this instance, instead of using the TOPO, the pavement markings will be used in the same 

fashion listed above. 

At this point for all 3 methods, it is time to take the created Traffic Plan and place it appropriately in a 

MicroStation border. 

5.3-2d Creating the Detail Sheet 

The final step for completing the Traffic Plans is the creation of the Detail Sheet for the project.  Working 

out of the Signals Plan drawing, import a separate Arch D size sheet model using Models tool with 

appropriate sheet border.  These borders can be found in the D size_sheets.dgn located in ProjectWise. 

 
Locating the D_size_sheets.dgn 

pw://indot-pw.bentley.com:indot-pw-01/Documents/Template%20Documents/DGN/D%20size_sheets.dgn
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With the border file located and opened, select the appropriate border from the list to Import into the 

Open dgn.  For example, the SG_Detail Sheet. 

 
Selecting the Detail Model 

This will bring a copy of the model into the active drawing.  Select this newly imported model and open 

the Reference Attachment dialog from the Home tab of the Drawing workflow: 

 
Attaching a Reference 
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Next, reference in the model containing the Intersection design as required to the appropriate scale (1”-

20’ or 1”-30’ as per IDM).  Note that an alternative method would be to drag and drop the model from 

the Models dialog to the References dialog. 

 

Intersection Attachment 

This concludes the Traffic Plans development process.  At this time, the final file is prepared for plotting 

using the tools discussed in INDOTWise 5.0 Plotting manual. 

5.4 MicroStation Drawing/Model Names 

See the tables in this section for the recommended naming convention for various type of DGN 

drawings/model names.  Please keep in mind that these can be applied to individual DGN models when 

one does not create a DGN for each file type. 

Note: Please abbreviate DGN/model names as needed using the INDOT standard abbreviations (i.e., Sht 

– Sheet, MOT – Maintenance of Traffic, etc). 

In the tables below, “nn” is used to denote the drawing number when there are multiple DGN’s (or 

sheet files) for the same type of drawing.  Users should note that it is acceptable to create multiple 

sheet models within a single DGN, thus eliminating the need for multiple DGN’s with the same 

description/drawing file name. 
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Description Drawing File Name Examples 

Road Project 

Title Sheet Sht Title.dgn  

Drawing Index and General 
Notes 

Sht Index.dgn  

Typical Cross Sections Sht Typical_nn.dgn Sht Typical_07.dgn 

Survey Route (Plat No. 1) Sht Plat1_nn.dgn Sht Plat1.dgn 
Sht Plat1_05.dgn 

Survey Route Plat with Aerial 
Photography (Plat No. 3) 

Sht Plat3_nn.dgn Sht Plat3.dgn 
Sht Plat3_05.dgn 

Geometric Tie-Up Sht Geometric Tie_nn.dgn Sht Geometric Tie.dgn 
Sht Geometric Tie_01.dgn 

Traffic Maintenance Details Sht MOT_nn.dgn Sht MOT 02.dgn 

Plan and Profile Sht PlanProfile_scale_nn.dgn Sht PlanProfile_50_01.dgn 

Superelevation-Transition 
Diagram 

Sht Super_nn.dgn Sht Super.dgn 
Sht Super_01.dgn 

Details   

Construction Details Sht Const Detail_scale_nn.dgn Sht Const Detail_30_01.dgn 

Intersection Details Sht Intersection_scale_nn.dgn Sht Intersection_30_01.dgn 

Spot Elevation Details Sht Spot Elev_nn.dgn Sht Spot Elev.dgn 
Sht Spot Elev_01.dgn 

Channel Details Sht Channel_nn.dgn Sht Channel_01.dgn 

Geometric Details Sht Geom Detail_nn.dgn  

Right-of-Way Details Sht ROW Detail_nn.dgn Sht ROW Detail.dgn  
Sht ROW Detail_01.dgn 

Grading Plan Sht Grading_scale_nn.dgn Sht Grading_30_01.dgn 

Drainage Details Sht Drainage_nn.dgn Sht Drainage_01.dgn 

Erosion and Sediment 
Control Details (plan view)  

Sht TEC_scale_nn.dgn Sht TEC_30_01.dgn 

Retaining Wall Details Sht Retaining Wall_nn.dgn Sht Retaining Wall.dgn 
Sht Retaining Wall_01.dgn 

Wetland Mitigation Details Sht Mitigation_scale_nn.dgn Sht Mitigation_30_01.dgn 

Traffic-Work Details   

Signs (if separate traffic-sign 
plans are not required)  

Sht Signs_nn.dgn Sht Signs.dgn 
Sht Signs_01.dgn 

Signals Sht Signal_scale_nn.dgn Sht Signal_30_02.dgn 

Lighting (if separate lighting 
plans are not required) 

Sht Lighting_nn.dgn Sht Lighting.dgn 
Sht Lighting_01.dgn 

Pavement Markings Sht Pvmt Markings_scale_nn.dgn Sht Pvmt Markings_30_03.dgn 

Road Summary Sheet Sht Road Summary.dgn  

Description Drawing File Name Examples 

Bridge Project 

Title Sheet Sht Title.dgn  

Index Sht Index.dgn  

Typical Cross Sections Sht Typical Cross Sections.dgn  

Traffic Maintenance Details Sht MOT_nn.dgn Sht MOT_02.dgn 
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Traffic Detour Details Sht Detour_nn.dgn  

Temporary Runaround 
Details 

Sht Runaround_scale_nn.dgn Sht Runaround_50_02.dgn 

Road Plan and Profile Sht PlanProfile_scale_nn.dgn Sht PlanProfile_50_01.dgn 

Superelevation-Transition 
Diagram 

Sht Super_nn.dgn Sht Super.dgn 
Sht Super_01.dgn 

Roadway Details (see Road 
Plan sheets) 

  

Traffic-Work Details (see 
Road Plan sheets) 

  

Soil Borings Sht Borings TB_nn.dgn Sht Borings TB_01.dgn 

Channel Change Layout Sht Channel_nn.dgn Sht Channel_01.dgn 

Layout Sht Layout_scale_nn.dgn Sht Layout_30_01.dgn 

General Plan Sht General Plan.dgn  

Structure Details Sht Structure.dgn  

Abutment/Bent/Pier Details Sht End Bent Details_nn.dgn 
Sht Pier No x_nn.dgn 

Sht End Bent Details_02.dgn 
Sht Pier No 2 and 3_01.dgn 

Framing Plan Sht Framing Plan.dgn  

Structural Steel Details or 
Precast-Concrete Beam 
Details 

Sht Beam Details_nn.dgn Sht Beam Details_01.dgn 

Bearing Details Sht Bearings.dgn  

Superstructure/Floor Details Sht Superstructure_nn.dgn Sht Superstructure_02.dgn 

Railing Details Sht Railing Details.dgn  

Screeds Sht Screed_nn.dgn Sht Screed_02.dgn 

Reinforced-Concrete Bridge 
Approach Details 

Sht Approach Slab Details nn.dgn Sht Approach Slab 
Details_02.dgn 

Bridge Summary Sht Bridge Summary.dgn  

Road Summary Sht Road Summary. dgn  

Pipe Materials Sht Materials.dgn  

Cross Sections Sht Xsec_scale_nn.dgn Sht Xsec_50_03.dgn 
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Description Drawing File Name Examples 

Traffic-Signs Project 

Title Sheet Sht Title.dgn  

Index and General Notes Sht Index.dgn  

Signing Plan Sht Signing Plan_nn.dgn Sht Signing Plan_01.dgn 

Sign Layout Sht Panel Sign Layout_nn.dgn Sht 
Sheet Sign Layout_nn.dgn 

Sht Panel Sign Layout_01.dgn / 
Sht Sheet Sign Layout_01.dgn 

Cross Sections Sht Sign Cross Sections.dgn  

Sign Summary Sht Panel Sign & Post 
Summary_nn.dgn 
Sht Sheet Sign & Post 
Summary_nn.dgn 

Sht Panel Sign & Post Summary 
_01.dgn 
Sht Sheet Sign & Post 
Summary_01.dgn 

Footing Details Sht Signal Footing Details.dgn  

Structural Details Sht Structural Details.dgn  

Signalization Project 

Title Sheet Sht Title.dgn  

Index and General Notes Sht Index.dgn  

Signal Plan Sht Signal Plan.dgn Sht US 41 & SR 57 Signal 
Plan.dgn 

Signal Details Sht Signal Details.dgn  

Lighting Project 

Title Sheet Sht Title.dgn  

Index and General Notes Sht Index.dgn  

Lighting Plan Sht Lighting Plan.dgn  

Cross Sections Sht Lighting Cross Sections.dgn  

Lighting Details Sht Lighting Details.dgn  

 

The following tables spell out the standard naming conventions for standard base drawings and sheet 

drawings, respectively. 

Standard Base Drawings 

Drawing Names / 

Logical Names 

Descriptions / 

Reference Descriptions 

Examples 

Survey Alignment Survey Centerline Survey Alignment.dgn 

Survey Section Corner US Government Section 

Corners 

Survey Section Corner.dgn 

Survey Contours Survey Existing Contours Survey Contours.dgn 

Survey Topography Survey Existing Topography Survey Topography.dgn 

Survey Triangulation Existing Triangulation Survey Triangulation.dgn 

Explan scale 

 

Design Existing Topography Explan 50.dgn 

Explan 100.dgn 

Design Alignment Design Alignment Design Alignment.dgn 

Prplan scale  Proposed Design Strings Prplan 50.dgn 

Prplan 100.dgn 

RW Existing scale Existing Right of Way RW Existing 50.dgn 
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RW Existing 100.dgn 

Annotate Alignment LineB 

scale 

Proposed  Alignment 

Annotation 

Annotate alignment LineB 50.dgn 

Annotate alignment LineB 100.dgn 

Annotate Survey 

Alignment LineB scale 

Survey Alignment 

Annotation  

Annotate survey alignment LineB  

50.dgn 

Annotate station offset 

LineB scale 

Annotation of Survey 

points with station and 

offset 

Annotate station offset LineB 50.dgn 

Annotate survey points 

LineB scale 

Annotation of Survey 

points 

Annotate survey points LineB 50.dgn 

 

Standard Sheet Drawings 

Drawing Names Descriptions Examples 

Planprofile LineB scale n Plan & profiles drawings  Planprofile LineB 50 001.dgn  

PlanProfile LineB 50 002.dgn 

PlanProfile LineB 50 n.dgn 

Layout LineB scale n Bridge layout sheet Layout LineB 50 001.dgn  

Layout LineB 50 002.dgn 

Layout LineB 50 n.dgn 

Const det LineB scale n Construction details  

drawings 

Const det LineB 50 001.dgn  

Const det LineB 50 002.dgn 

Const det LineB 50 n.dgn 

Pvmt Markings scale n Pavement marking details Pvmt Markings 50.dgn 

Pvmt Markings 50 01.dgn  

Pvmt Markings 50 02.dgn 

Pvmt Markings 50 n.dgn 

Runaround LineB scale n Temporary Runaround plan 

profile drawings.   

Runaround LineB 50 001.dgn  

Runaround LineB 50 002.dgn 

Runaround LineB 50 n.dgn 

TEC det LineB scale n Temporary Erosion Control 

details 

TEC det LineB 50 01.dgn 

TEC det LineB 50 02.dgn  

TEC det LineB 50 n.dgn 

Intersection Det scale n Intersection details Intersection det 50 n.dgn 

 

For the sheet drawings shown above, the alignment name, scale, and sheet number indicate which 

alignment, scale, and sheet number is reflected.  Following this convention will allow easy 

differentiation between alignments and scales. 
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6. Working with References in the MicroStation Platform 
This chapter will cover how to work with references in the plans production process.  With the emphasis 

on the use of models in our plans production process, it is very important to understand how references 

are used to create design/sheet content. 

6.1 Using References 

Elements in a reference display as though they were in the active model. Although you cannot 

manipulate the elements in a reference, you can snap to them and even copy them into the active 

model. 

The most common usage of references is in the creation of design compositions. Design compositions 

are used by engineers and other technical professionals to communicate through the visual content of 

their designs. 

To create a design composition using MicroStation, you build a design model consisting of a working 

collection of references used in the performance of particular engineering tasks. For example, you may 

attach as references a collection of survey points as a guide for placement of additional geometry. 

Reference attachments in a design composition are usually coincident. 

It is sometimes convenient to refer to one part of a model while drawing in another area by attaching 

the active model to itself. 

Another common usage of references is in the creation of drawings for publication. This task is called 

drawing composition. Whereas a design composition is typically contained in a design model, a drawing 

is composed in a sheet model. 

6.2 Attaching References 

The most common way to attach a reference is to attach it with a Coincident – World orientation.  This 

means that the global origin of the reference file will be matched to the global origin of the active file.  

With this orientation chosen, when a user snaps to elements in the attached reference, the coordinate 

information will be correct.  To attach a reference with Coincident – World orientation, perform the 

following steps: 

1. In the active file, click on the Attach Tools button in the Primary tool group of the Home tab in 

any workflow. 

 
Attach Tools 
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2. On the References dialog that appears, click on Tools > Attach.  Alternatively, you can click on 

the Attach References button, or you can right-click in the Hierarchy or reference listing panes 

and choose the Attach option from the menu that appears. 

   

Options to Attach a Reference 

3. On the Attach Reference dialog that appears, select the DGN file that contains the model you 

want to reference into the active file. 

 
Attach Reference Dialog 

4. On the Reference Attachment Properties dialog that appears, note the Model setting.  By 

default, the reference’s master model is selected.  If the model you want to reference into the 

active file is NOT the master model, select it from the dropdown list. 

5. In the Orientation section of the dialog, select the Coincident – World orientation if it is not 

already selected. 
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6. With the correct model and orientation selected, click OK to proceed with attaching the 

reference. 

 
Reference Attachment Properties Dialog 
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6.3 Working with Nested References 

When a MicroStation platform-based design file being used as a reference has its own attachments, they 

become nested references. The links between these files can be maintained through many levels 

(depths) of nesting, so that if you open only one file, you can view the contents of many files. The 

individual references can be updated, and the changes will be shown in the master (or parent) file. 

When you attach a parent reference to your model and turn on live nesting, you can also control how 

many levels of nested references are attached to the model. 

To attach a reference with live nesting turned on, perform the following steps: 

1. Perform steps 1 through 3 from the previous section to open the References dialog and select 

the file containing the model you want to attach to your active file. 

2. On the Reference Attachment Properties dialog, note the Nested Attachments setting.  If not 

already selected by default, select the Live Nesting option. 

3. For the Nesting Depth setting, enter an appropriate value such that it properly encapsulates all 

of your nested references.   

 
Nested Attachments and Nesting Depth Settings 

Once the reference is attached, pay attention to the Hierarchy pane of the References dialog.  Note the 

hierarchical structure of this pane, as it is helpful to visualize the current nesting that is in place.   
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Hierarchy Pane of References Dialog 

The Nested Attachments and Nesting Depth settings will be explained below in more detail. 

Nested Attachments 

This setting determines if referenced models attached to reference models (and so on) are recognized 

when a model is attached to the active model. 

• No Nesting — Models attached to the attached model are not recognized in the active model. 

• Live Nesting — Models attached to the attached model are recognized in the active model. 

• Copy Attachments — Models attached to the attached model copied into the active model. 

When working in a DWG or DXF file, live nesting is always on, and there is no limit to nest depth. 

Therefore, the Nested Attachments and Depth items are disabled. To control the display of nested 

attachments, use the Ignore Attachment When Live Nesting setting (on the Attachment Settings dialog 

box). 

Nesting Depth 

The Nesting Depth setting sets the number of levels of referenced models that are recognized. Models 

can have their own referenced models, which, in turn, can have more referenced models, and so on. 

If the depth is set to 0, only the selected reference model is attached to the master model; referenced 

models in the referenced model are ignored. 

Note: Care and understanding of how your nested references are configured is very important.  Due to a 

known defect that CAD Support has brought to Bentley’s attention, entering an arbitrary high value for 

this setting could produce duplicated displays of your references in the plan sheet creation process.  

More information on this issue can be found in the INDOTWise 5.1 ORD Plans Production document. 
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